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Preface

Thank you for buying a Laser machine engraving and cutting machine. This
machine is a high-tech product of laser, mechanical, and electronic technologies. To
allow customers to use this machine to its fullest potential, we have written this

manual.

This manual will show you how to install, debug, operate and maintain your
machine. To this end we have incorporated many easily understandable icons. We
have also addressed the safety issues concerning lasers to allow you to safely
operate your equipment. Kindly read and understand this manual well before

operating your machine.



Safety Note

1. Users must read this manual carefully and understand it fully before
using the machine. Operationl instructions must be strictly followed and
staff, not fully trained, must not be allowed to use the machine.

2. The machine is equipped with a class 4 laser (strong laser radiation), and
the laser radiation may cause following problems: 1. ignite flammable
material 2. release toxic gases 3. cause severe skin burns 4. severely damage
your eyesight.

3. Fire extinguishers must be available at the machine and no flammable
material must be stored close by. Exhaust from the machine must be properly
filtered or ducted outside according to local ordinances. Untrained personnel
must be kept away from the machine.

4. Beware of high voltage in the laser and electrical compartments. These
must be accessed only by trained personnel.

5. Do not leave a running machine unattended. The operator must turn the
machine off before leaving.

6. Do not open any doors while the machine is running.

7. The machine and its peripheral devices must be electrically grounded.

8.  The operator must constantly monitor the machine when it is in
operation and turn it off if abnormal conditions occur.

9. The machine must be operated in dry conditions and away from
pollution, vibration or strong electrical and magnetic fields. The ambient
temperature should be between 5 and 40 degree centigrade (40-104 degree
Fahrenheit) at a humidity 5-95% with no condensation.

10 . Do not install this machine near electro-magnetically sensitive
instruments.

11. Electrical connection: 220VAC, single phase, 50/60Hz; total connected
load <2000W.

Please note, LASER MACHINE will not be responsible for any
improper use of the machine.



Declaration

Due to continuous improvement of the product, the content and illustrations

of the manual may differ a little from the machine delivered.



Chapter 1 Appearance of the Machine and Its Optional

Attachments.

1. Appearance of the machine (may change somewhat for different models)
Front View of the machine, figure F1-1:

Laser meter and power adjustment switch

working table Front Door control panel

Brand nameplate Laser head(one or two) Foot

F1-1



Rear view of the machine, as shown in figure F1-2:

Main power Laser tube box door

Earth wire Back side door
Power socket for accessories Water pipe interface

F1-2



2. Your machine may or may not include the attachments shown below.

A. Laser Power Supply:

Front view of laser power supply F1-3

air compressor

F 1-4



C. Exhaust Blower, Air Hose, as in F1-5
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D. Lasertube F1-6
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F. Optional Honeycomb Working table- F1-8

F1-8

G. Stripped table (optional fitting ) - F1-9

F1-9



Chapter 2 Machine Installation

A working laser cutting and engraving machine consists of the basic machine,
a laser power supply, an exhaust fan, an air compressor, and a water tank with
pump (or water chiller). Also included are the necessary pipes, hoses and a

communication cable.

A. Installation Procedure:
1 Installing the laser tube
As the laser tube is made of glass, we pack it separately to keep it safe during
shipping. Therefore the laser tube needs to be installed before the machine can be
used.
As shown in picture F2-1, the laser tube fits into the top compartment in the

rear of the machine.

F2-1

Untie the hold down straps of the V brackets and carefully place the laser tube
into the V- groove with the negative pole toward the #1 mirror. See picture F2-2:
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Fasten the hold- down straps over the laser tube. See picture F2-3

F2-3
Note: The distance between the laser tube nozzle and the #1 mirror must be
about 1 cm (0.4”)

Attention: 1 Do not over tighten the hold down straps over the laser tube and
cushion the V- brackets with foam rubber. 2. Make sure that the water inlet (at
beam exit side of the laser) is at the bottom of the tube.

After installing the laser tube, connect the water inlet of the laser tube (at
beam exit side, picture F2-4) to the water outlet of the chiller (or water pump) and

connect the water outlet of the laser tube (picture F2-5) to the return port on the
chiller.

F2-4 F2-5
Each water hose must be connected firmly in order to avoid leaking.

Finally string the laser tube electrical wires, As in F2-6
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Negative wire Positive wire

2. Installation of the laser power supply
Place the laser power supply into the machine compartment under the
work-table. Connect the red color positive wire connector as Picture F2-7

F2-7
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The high voltage connector should be fixed on top side and don’t touch to any
machine steel frame. F2-8:

F2-8
After connected well, the laser powe supply same in figure F2-9




3.  Water pump/Chiller installation

Fill the plastic water tub with pure water. Connect the pump to the water outlet
connection and insert the water pipe. Put them in the water tub and connect the
water pipe to the engraving machine water inlet. Use another water pipe to connect
to the engraving machine water outlet. As in figure F2-10, F2-11:

F2-10 F2-11
Turn on the power to the water pump. You should see that water will gradually

fill the laser tube. The water flow is monitored by a flow switch, which will prevent
the laser from operating if the flow of water has ceased or is insufficient. Water
level and cleanliness need to be checked as part of daily maintenance.

If it is a chiller, set the water temp to 5 deg C lower than max. room temp.
For example, if max. room temp is 30 Deg C, set chiller temp to 25 Deg C.

4. Installation of the air compressor:
Connect the air compressor outlet with the inlet of the engraving machine and
turn on the power to make sure that air flows normally. As in figure F2-12:
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When cutting and engraving, pressurized air will exit through the focusing
nozzle on the laser focusing head. This will keep the focusing lens clean and protect
the work material from being ignited. The air flow will affect the quality of your
work. Therefore periodically inspect the air hoses and keep them in good
working order.

5.  Laser Beam Adjustment:

Connect all electric lines and turn on the power of the engraving machine. The
machine will reset and return to the origin previously set (starting position). This
indicates that the machine is working normally. Now, turn on the power of the laser
generator to adjust the beam path. First, adjust mirror #1. Move the gantry and the
focusing head to the left rear, which brings them closer to mirror #1. Place a piece
of masking tape over the beam entry on the focusing head and pulse the laser with
the PULSE button on the operator panel. The beam will leave a mark on the
masking tape. Now move the gantry and the focusing head to the front left position
and pulse the laser again. If the two marks are not in the same spot adjust the
mirror using the three screws at the back of the mirror. F2-13

#1 mirror
Adjust mirror as
described for mirror #2

w
Jounwu § |

rotate

clockwise

light
moves moves
down, right,

vice versa vice versa

drawtube

F2-13
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After adjusting the first mirror, mirror #2 is adjusted in the same way, except
this time the focusing head should be moved left or right while keeping the gantry
still.

Note the position of the beam should be in the center of the mirror. If it is not
in the center of the mirror, adjust the mirror again until it moves to the center.

Finally, check whether the burn marks from all four corners of the table are
superimposed. If the four marks are not superimposed you will need to readjust
mirrors 1 and 2.

After the four points are in the same spot, make sure the beam is in the
center of the opening of the laser focus head. If it is not at the center of the beam
entrance, turn off the laser power supply and adjust the position of the laser tube. If
the beam is offset horizontally, adjust the laser tube in the same direction. For
instance, if the beam is off to the left, adjust the laser tube to the left.

If the offset is vertical, adjust the laser tube in the opposite direction. For
instance, if the offset is up, adjust the tube down (equally on both brackets). If the
offset is down, adjust the laser tube up. (Picture F2-16)

Note: If only small corrections are required just adjust the right hand V- bracket
(at the beam exit side of the laser) in the way described above. If the left bracket
needs any adjustment, the adjustments are in the opposite direction.

Detailed instructions about adjustment are also found in chapter 4 < Beam Path
Adjustment Standards>.

After adjustment, close the guard door to protect the laser tube.

6. Installation of the Exhaust Fan

First, use the furnished air hose to connect the fan to the exhaust port on the
engraving machine and tighten it firmly with a hose clamp. Then use another air
hose, to connect the outlet of the fan to an outside vent. Some local regulations
might require exhaust filters (not included with the machine) when cutting and
engraving toxic materials. Check with your local authorities. Finally plug the power
cord into the distributor and the exhaust fan is connected. See Picture F2-14:
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7A. Computer Requirements.

A Windows XP/7 based computer is required to prepare programs to be
downloaded into the machine memory. Below is the suggested computer
configuration :

Hardware:

Motherboard: Intel 854 chip set series (ASUS, MSI)

CPU: frequency 1600HZ or above (P4 1.6G or Celeron 1.7G)

Memory: DDR256M or above (HY.SUMSUNG)

Graphic card: 32M memory (LEADTEK GF200,GF400)

Hard disk: 40G 7200 above (Diamond seven series, IBM series)

Monitor: 17” flat CRT display (BENQ.SUMSUNG)

Floppy drive: 1.44 M (SONY, NEC)

CD driver: 52 speed series (SUMSUNG, MSI)

Power: 300W series brand (GREAT WALL, STAR)

Scanner: 600dpi or above (UNISCAN A700.A800)

Printer: 8.5”x11” or A4 series (HP3325. EPSON C41)

UPS: 500W or above (SANTAK, KSTAR)

Software:

Operating system: Microsoft Win 7, Windows XP (purchased by customer)
Application software: Microsoft Office Series, tools (optional)

Graphic software: Corel Draw 9.0, Corel Draw 11, Photoshop 6.0, AutoCAD 2000
Machine control software: Smart Carver ( provided with the machine)
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The above configuration is for customer’s reference only!

7B.  Grounding the machine

In order to function properly, the machine must be electrically grounded via
the electrical ground wire in your electrical system. If your wiring does not include
a ground wire you need to install a ground to the following specifications:

Ground cable technical requirements

1. The grounding device must have 4 pieces of 35mm steel rod to be dug into
a moist place near your building. Each piece must be at a 1 meter distance from the
other and should reach down to a depth of 1.5 meter. Then use 3 X 30mm flat iron
to connect each piece to combine to an efficient ground network.

2. Make sure the resistance of ground device is between 3-5 ohm

3. A RVV 2.5MM2 copper wire will connect the ground device and the
entrance of the cable switch of the customer’s electrical machine.

4. Ensure the wire is properly grounded complying with our technical
requirements in this working sheet, to assure that our laser machine can work

properly.
Cable switch

Wire

Flatiron

Flatiron >

A

m
" Steel stick
1.5m

-
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Chapter 3 Software installation

1.1 Install steps

(D

(2)

Double-click the RDCAMSetup.exe under the installation directory, the following dialog box
appears:

<A RDCANG. 0. 01 Install

Welcome to the RDCAM Setup Wizard

This wizard will guide you through the installation of RDCAM,

1t is recommended that you close all other applications before starting Setup. This
will make it possible to update relevant system files without having to reboot your
computer,

Click Next to continue.

[ Instal | [ Cancel ]

Click [Install] , when extract copy is to be completed, the installation main interface appears:

Install USE driver Unistall USE

Type: l Laserfork v
Language: Simplify Chinese W
Mainboard: \RDLC320/RDCB33X

DLocate install path
[Jren drawing lines

) e L e e e b
I LUZ LAaZSernori

E] Demo wersion

Install l Exit J
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1.2 Installation settings

The installer can choose different installation content.

1>
2>

Install/Uninstall USB driver , reference {Install USB driver)
According to the different customer application needs and the habit of using to

select the type of software

3>

4>

5>

6>

7>

8>

a. Stand-alone software LaserWork.

b. The software that plug-ins to CorelDraw. Support the version from Coreldraw11 to X5.

c. The software that plug-ins to AutoCad. Support the version from 2004 to 2010.

d. The software that plug-ins to Cadian.

e. The software that plug-ins to Illustrator.

Choose a different installation languages

At present, it support Simplified Chinese, Traditional Chinese, English and the custom language type.
Select the software matches the motherboard

The software can support three kind of motherboards:RDLC430. RDLC320. RDC633X.

Both RDLC320 and RDC633X are compatible, but RDLC430 is different. So, please choose the
corresponding software with motherboard. Otherwise, it does not work.

Locate install path

When install the LaserWork, default install path is “C:\”, for change the install path, check this option.
When install the plug software RDPlug, under normal circumstances, the install program  will locate
to the target software automatically. If the installer does not locate to the target software automatically,
you need to check this option, and locate to the target software manually.

Pen drawing lines

This option is only applicable to a particular machine, which has the function of the chalk line,
ordinary machines do not need to check this.

Plug laserwork

The installer default install a special plug-ins RDPlug, if the users are more accustomed to using
LaserWork program ,can check this.

Demo version installation

According to the type of software installation, the installation language, the choice of motherboard
generate different versions of the DEMO Software.

1.3 Installation

Choose the type of software, installation language and the appropriate motherboard. Click [ Install] to

install the software. After installation is complete, the following dialog box appears to prompt the user that the

software has been installed successfully.
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RLaserSetUp¥6 @

L) \
\l) Install Finish!

1.4 Exit

After installing the installation needed. Click [Exit] to end the installation process.
Because of the possible need to use several installation, so the installation dialog does not automatically

exit, until users click button [Exit] .

1.5 Other matters

1> Before installing the plug-in software, the software that has been articulated should be shut down. After
installation, restart the software.
2> The regular version and the DEMO version of the plug-in software is covered by each other.
3> In the default installation path, the normal version and the DEMO version of the independent software
and different types of independent software motherboard with each other.
For the same time to install two versions, select the [ Locate install path ] .The regular version and the
Demo version should be installed in the different location.
In addition, need to the appropriate software installation location, manually add a desktop shortcut for
the software.
4> Modify the information of manufacturers
In the package, in addition to RDCAMSetup, there are four text files.
Info Sche. Info Tche. Info En. Info Other, the four files correspond to the software information of
manufacturers that be displayed in Simplified Chinese, Traditional Chinese, English and the custom language.

If the four text is modified, manufacturer information also will be installed when the program was installed.

Open the text that should be modify, an example in Simplified Chinese:
0 = Company Name:
1 = ... (Fill in company name here)

And so on, the company information in other languages is the same set.
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Chapter 3.1 The plug-in of CorelDraw installed

Plug-in software support the version from CorelDraw11 to X5, but some simplified versions of CorelDraw
is not supported. Here to the installation of CorelDraw12 as an example to introduce the installation process of
plug-in software. If not specified, it is referring to CorelDraw12.

Before installing the plug-in software to run CorelDraw.

#/O W B
=
BEX®@...
Q- HesER ). ..
B REHEARIME @

Select [Tools] -> [Option]

A B
E Iftgﬂ vBA
_%i‘- Rt
ig &), RREER = ;
R O B RS LR ETRRENEEST
Bh7aRhE .
E © o). EAERLEETEERLBENE.
VEA MV ) =
O 1 GRINE ) (L) H ER SRR .
o ey AR R
A WS MBS TR,
) = i
 TRu VI SRR s 85 @
B BEX
ggr; THEBE
BEis [ ERERIRAR vBA HE
R AFTAVBAL#E:
Y (I SRS vEA AR
FlH GNS FRERHT:
[CI3ER$EA vBA
mEo | [ BEo | [ #ho |

In the pop-up dialog box, select VBA, on the right do not check the “delay load VBA”, then OK, and exit
the application CorelDraw.

Run the program of installation, choose “Type” to “CorelDraw_Laser”, then click [Install] .
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Install USE driverJ Unistall USE

Type: .
Language: ; English v ]
Mainboard: \RDLC320/RDCE33X v |

[TLocate install path
[Jren drawing lines
DPlug Laserfork

DDemo version

Install ” Exit

The installer will automatically install the plug-in software to the all versions of CorelDraw RDCAM that
are installed on the operating system and pop-up dialog box.

RLaserSetUp¥6 @

o \
1 ) Install Finish!

For some versions of CorelDraw (such as green version) may not automatically navigate to the locate
where the CorelDraw is installed on. Only need to check “Locate install path” on the installation software, and

then manually browse to navigate the folder location to the root of CorelDraw software where the plug-in
program should be installed on.

Exit the installation program, and run CorelDraw.

oY
Toolbar in the CorelDraw interface will appear - .

If the button does not appear, you should select [Tools] -> [Option] in the menu.
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Visual Basic Fe ... STiZsh T BRI (W)

B RLaserCuts.0
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On the left select the “command bar” and then check “Visual Basic applications”, and select “OK”.

‘ b El]g]"o 1l _I‘

this tool bar will appear in the software, select the first button b .

If the toolbar does not appear, reinstall the software CorelDraw.

ZBHR M) : =
=17 ®)
RLaserVB. ImportDstFile il

RLaserVb. Laser'forking
RLaserVb. UserInit

b = 1) T 'GlobalMacros (RLaser12V6. gms) v]
£y

In the “macro location” select “GlobalMacros(Rlaser12V6.gms)”.
And the “Macro name” choose the RlaserV6.UserInit. And then “Run”.
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Chapter 3.2 The plug-in of AutoCad installed

AutoCad plug-ins can be used to AutoCad2004-2010 non-simplified version. Here to the installation of
AutoCad2004 as an example to introduce the installation process of plug-in. If not specified, it is referring to
AutoCad2004. Close all running AutoCad programs before AutoCad plug-in installed.

Run Setup. Select “AutoCad Laser” as The “Type”, and then click [Install] .

¥Yelcome to use

Unistall USE

Install USE driverJ

 —

Type: kutoCAIl Laser V}
| . ]
Language: English b
| |
Mainboard: \RDLC320/RDC633X v |

DLocate install path
| |Pen drawing lines
DPlug Laserfork

DDemo version

l Install ” Exit ]

Setup will automatically install the RDCAM plug-in software to all versions of AutoCad that were

installed on the operating system and pop-up dialog box.

RLaserSetUp¥6 @

o
1 ) Install Finish!

For some vesions of AutoCad(such as green version) may not navigate to the locate where the AutoCad
was installed on. Only need to check “Locate install path” on the installation software, and then manually
browse to navigate the folder location to the root of AutoCad software where the plug-in program should be
installed on.

Exit the installation program, and run AutoCad.

Toolbar interface in AutoCad will appear Q

If the button does not appear, select [Tools] -> [Macro] (A)->Macro(M) in the menu.
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AutoLISP (3) Y omEIREQW...
&2 ucsan. Visual Basic $RiEag (B) Alt+F11

If you can not find it in the menu, it is because the version of AutoCad may not support the plug-in. Pleast

re-install a full version of AutoCad.
®

EEWW:
:\Program Files\AutoCAD 2004%acad dvb!LaserV6. LaserInit

)
X

[C:\Program Files‘\AutoCAD 2004%acad dvb!LaserVb. LaserIni{ XH]
C:\Program Files\AutoCAD 2004\acad. dvb!LaserV6. LaserRumn
FE5Bh ()

|

=
! i
; KD
&

ESEaeY)
¢miE (E)

RS (@)
< > A BER V). ..
ZE Q) | FAAEsERAIRE v ETW @), ..
WBH (D)

In the pop-up dialog box, select LaserInit, and run.

The plug-in toolbar can occur if you select this option, but when you close AutoCad and then open the
AutoCad software again. But also do not see the toolbar. Then it is possible that your computer is infected with
a virus. You must manually to define the boot loader works of AutoCad, or you can re-check for viruses or

reinstall the operating system and AutoCad software.
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Manual process of loading plug-in as follows, select the menu [ Tools] ->AutoLISP->/JI1%.

SEQ I BRW BUETEE 50

Autodesk FAEL (A) é// étandard v | "4/ :
CAD #RifE (S) 4 = - -

HERE @

ERIEIERE ®). ..

ETIRF @) ’
=519 @Q) ’

[EHARER (). ..

TR EESE O Ctrltl
it ) Ctrl+2
TEEMEEFO E) Ctrl+s
EEIERE D) Ctrl+6

MnERAERF L. ..
ETHER). ..
% Q) >

D

Visual LISP 4RIBS3 (V)

BmENR
In the dialog box, you should to choose the “Content” button that was under the “Start Group”.
jLIE AR E AT 3
EHIEE @) | ) AutoCAD 2004 v O 2 -
::;jData Links JFlotters |_)WebDepot 7
) Drv |_)Sample )febServices
(()Fonts | ) Support acad. dvb
([ )Help ) Template AcApp. arx
;j LaserfforkVS ) Textures Aci\rray. arx
[C)Flot Styles UserDataCache AcArxAdlm. arx
< b

XS W) |

ISR (T | AutoCAD FEFRIRRE (k. arx;*. lsp;*. dvb; v

EMSRNBES | fHeidRolwE | OFmBImEER o
Xt i EES ]
BahiH
¥
AcDblCL. .. C:\Program Filesh\AutoCAD ... ¥
< > RE Q). ..

ESCRIEEEN

Select “Add” button in the pop-up dialog box. In the AutoCad directory, manually locate and select
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acad.dvb,acad.lsp. And loading these two files.

FERERFAIR:
it 1

i acad. dvb C:%Program Files\AutoCAD 2004\
acad. 1sp C:\Program Files‘AutoCAD 2004\

e [ xA© [ e |

Adding the file, close the dialog box, and then close the AutoCad. You can see the plug-in toolbar when you
open the AutoCad again.

Chapter 3.3 The plug-in of Cadian installed

Cadian plug-in are now available for the non-simplified of Cadian2010. The other version is not tested.
When Cadian was installed, you should close the running Cadian procedures.
Run Setup. Select “CaDian Laser” as the “Type”. And then click [Install] .

¥Yelcome to use

Install USE driver l Unistall USE

Type: [Cadian Lzer 1)
| .

Language: \English v '

Mainboard: \RDLC320/RDC633K v

DLocate install path
| |Pen drawing lines
DPlug Laserfork
DDemo version

Install Exit
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As CaDian is green software, installation program can not automatically find the installation directory
where the need to manually locate the installation path. Select the CaDian installation folder, and click “OK”
button.

42 Browse for Folder @

Select destination Folder. 'Visual Assist X' will be added to the
chosen path.

|{C) AutoCAD 2010 ~
) AutoCAD LT 2005 ¥
) {fj Autodesk
]{C) Business Objects
A&} CAD: 202010
) {fj CE Remote Tools
]-{C) Common Files

{fj ComPlus Applications
2] {lj Corel

+ {fj DAEMON Tools Lite
F-47 easvilule 5 b

BB

+

| s

[ OK ][ Cancel ]

After installation is complete, the following dialog box appears.

RLaserSetUp¥6 @

L
1) Instsll Finish!

Exit the installation program, and run CaDian.

Chapter 3.4 The plug-in of Illustrator installed

[Mlustrator plug-in are now available for the non-simplified of Illustrator CS5. The other version is not
tested. When Illustrator was installed, you should close the running Illustrator procedures.
Run Setup. Select “Illustrator Laser” as the “Type”. And then click [Install] .
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¥elcome to use

Install USE driver Unistall USE

Type: T |
Language: LSimplify Chinese v]
Mainboard: \RDLC320/RDC633X v |

DLocate install path
[Jren drawing lines
I:]Plug Laserfork
DDemo version

Install [ Exit

As Illustrator is green software, installation program can not automatically find the installation directory

where the need to manually locate the installation path. Select the Illustrator installation folder, and click “OK”
button.

<2 Browse for Folder

Select destination Folder. 'Visual Assist X' will be added to the
chosen path.

4fj 95599 Certificate Tools ~

{3 39080508

=] ﬁ_ﬂ Adobe
* {fj Adobe Tllustrator CS4
CR@YT11ustrator CS5
() Photoshop CS
# {fj Reader 9.0

ib Ahead

) Alifanghang

4fj American Laserfare

{7 Answerforks 4.0 5 b

| RS

[ OK ][ Cancel ]

After installation is complete, the following dialog box appears.

RLaserSetUp¥6 @

o
1 ) Install Finish!

Exit the installation program, and run Illustrator.
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SOFTWARE OPERATION MANUAL
Chapter 1 Overview

1.1 Laser engraving cutting system introduction

Laser engraving cutting system through a computer numerical control machine tools to achieve effective
control, according to the user’s different requirements of the completion of processing tasks.

The system including control board and control panel, and supporting software. This manual describes
how to use the software to complete the task of laser processing.( Motherboard wiring and control panel

operations, see the accompanying manual and control panel wiring board operating instructions)

1.2 Software supported file formats

Vector format: dxf, ai, plt, dst, dsb...etc.
Bitmap format: bmp,jpg,gif,png,mng,...etc.

1.3 Environmental requirements

(1) WindowsXP operating system and above, XP recommended.
(2) Above CPU586,above PIII or PV recommended.

(3) Memory, above 1G recommended
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Chapter 2 Software Basic Operation

2.1 The main interface operation

After start the software, you can see the interface shown in the following figure.

Menu bar Graphics bar System bar Align bar

Default —

File(E) EHit(E) Draw(D)  Config(d) Handle(W) View(y) Help(H)
DiEHdH ra TRQARRA Dol Vel B %% BInwsd wnosl@RANMKE
%[ mm e[ Jmom | 2T
¥ _Jom Plo Jom|[0 e ﬂ]ﬂ (€4 Y
S I P IO IO I - IO . I IO IO IO - OO I . =
\ Iy \ = = S Work | Output | Doc | User | Test | Transform
£ = Layer | Mode  Speed  Power  Output
"t
A E .
T Edit bar
O~ :E
=) .
=l Control panel [«
A =
o =
EE
=
B E Linejcolumn setup
B Num space(mm) Dislocation(mm)
x 5 %:[1 o 0 E
A E vt 0 Jlo
= =
154 2
lE-
O 3
z x
~ Laser work
B [ stat ][ Paussicontinue |[ st |
2]
E Layel' bar [ savetourie ][ uFieoutput [ Download |
_; L Path optimize Go scale
: ﬂ [ouput selectgraphics
E Device
= UsB:Auto ]
& It Psition: Current postic v
x —
EEEES EEEEEN & SEEC
= 1R{8) T 2 ARIRBEEER S {5 fas2 e A :329. 34Snm, ¥:177. 307nm

Menu Bar: The main function of this software are available through the implementation of the Menu Bar.
Execute the menu command is the most basic mode of operation. Menu Bar including: Document. Edit. Draw.

Setting. Processing. View and Help.

System Bar: On the System Bar, placed some most commonly command buttons which is chosen from the

menu.

Graphics Bar: Graphics property bar is the basic attributes of graphics operations, including graphic location,

size, scale, number processing.

Edit Bar: The Edit Bar default on the left of the work area. In the Edit Bar placed frequently used tools to

make the operation more flexible and convenient.

Align Bar: Alignment of the selected objects.

Layer Bar: Change the layer of the selected objects.

Control Panel : Using the Control Panel to complete laser processing of multiple tasks, Layer parameter

settings, axis control, processing ...etc.
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2.2 Language settings and manufactures information

In addition to installation process can set the software language type, you can easily switch in different

language.
Page setting @ Click Menu Bar [Help)] -> [i& 5 /Language ] expand menu, select the
o e required language types.
Page width: 200 mm

Page height: 1?00 :; mm Help(H)
Grid About RDCAM L: i

Gridspace: (S0 | mm | {&3/Language fal i
- T .
Keyboard gﬁq:i !
Adust distance: 11 | mm DI RRRAN IGOIUIDI vl I?C:OI.OI | EI"IgIISh L
Adijust ratio: ;10 ' Other

Adust angle: |1

To obtain manufacturers information,so that we can provide you with better
(ol g service. Click Menu Bar [Help] -> [ About RDCAM ]

Background:
o

Grid: I {

Corp. Mame: |
[ Ok l [ Cancel ]

Tel: ‘

Addr: [

Web: ‘

|

|

Fax: l J
' |

|

How to set manufacturers, refer to (RDCAM software installation instructions)
The bottom of the dialog box shows the current software version number. As different versions of software
may be have some differences on the functions and interfaces, you can easily contact and communicate with

manufacturers through software version number.

2.3 Page Setting

Click Menu Bar [Config] -> [Page setting] the following dialog box appears:

[ Page width]): Software page width, usually associated with machine X breadth.
[ Page height): Software page height, usually associated with machine Y breadth.
Under normal circumstances, if you have connected to the motherboard, software will automatically
format for the current work of the machine, as a page size.
If the board is not connected, or need their own custom page size (such as to set the page size by material),
you can use the page setting to reconfigure the page size.
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[ Grid]
Setting gird space and whether enable grid.

[Keyboard]

User can use arrow key to moving or rotating the selected graphics.
[ Color config]

Setting the color of the work area.

2.4 File Open and Save

The software uses rld file format to save graphic information. layer parameters of various layers and processing

sequence of the graphic elements.
2.4.1 Open File
Click menu [File] > [Open] ,or click icon, the following dialog box appears:

Open. . . @

HHEE @) [iozﬁﬂﬂmﬁ @:) LI 4= ck Ea-

Select file
ML @ |Default.rld | fIF @ I
IR @) |x.r1d | il

[~ BREATEITH ®)

(2) Select file (e.g. Default.rld), click [Open].

2.4.2 Save File

(1) Click menu [File] -> [Savel ,or click icond the following dialog box appears:

B PIX

BFED: | FHRSE 0) ~| = @ ef B

[ Defauit. 14

Input file name

|
B A VED e Faul t r1d] / {7 ©) |

{RIFER (D) : IRLaser Files (k. r1d) I __V_] Wil

/
/

(2) Enter the file name in the edit box, then click [ Savel.
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2.5 File Import and Export

Because this software is rld format, so to make or edit the use of other materials will be done by importing.
After using the Export to graphic files for other software.
Supported file format for import : dxf, ai, plt, dst, dsb...etc
Supported file format for export: plt

2.5.1 File Import

Click menu [File] -> [Import], or click icon &) o The following dialog box appears.
Select file,and click [Open].

SA 2353
SEREQO: [Omr - e ® e B
] 0000033, p1t o] €. p1t ] BFTE. 1t
o] 987 51t o) EETEFIL Lt ) R oLt
] 7000, p1t lour] S04 1t
o] 9676, p1t o] 5. p1t
] 080721, 1t ) TR EIR. 1t
o] AT. 1t ] 2R p1t
1 ne o1 [T
pu] ALphabet. p1t ] & p1t
o] ADP. p1t o] ERERETE. pLe
oa] Beach. pl1t o] . p1t
o] Box and Curve.plt |p] EIFL. p1t
o] Box. p1t ) ElFE22323. p1t
] Business. plt o) FEEA-2. p1t
o] Circle. plt o) 58, p1t
|pu] CONGER. 1t ] TSRS p1t
o] Curve. p1t ) L. plt
eu] gemn. p1t o] /M. plt
] Job 2. p1t ] MR p1t
] shoel2. plt e 543 p1t
o) 2.1t o) AR p1t
o) R p1t ) 8. 21t
[V Preview
B @ IA)rplanev plt @ Open |~
TR @) [Supported Filest ~l i

@ Select [ Preview), the selected file can be shown.

For most vector file,data automatically imported into the corresponding layer of RDCAM software according to

the layer description.
For some special documents such as DST/DSB, data will be imported into the current layer.

SA 3]
BEHRBEO: [5ost ~ e ®mekE-

= LS045-. DST

= 0. ST

=) PoRSCHEZ. DST
=) SwwFLOWR. DST
=) VERONTEA. DST

IV Breview

IHE W |AI\udxe1.DST & Open |

J2E (1) [Supported Filest ~]| il

Current layer
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2.5.2 File export

Click menu [File] -> [Export] or click icon CH o The Export dialog box appears.

Input file name,and click button [Save] .

2.5.3 File parameters setting
PLT Precision: According to the accuracy of the original plt file to select the appropriate import unit.

Smooth curves: When import vector file, automatically smoothing the original curves. For the original graphic
is smooth or need to repeatedly adjust the beset smoothing effect, you can uncheck this button. Do not do

smoothing curves may reduce time of import processing.
Auto close curves: According to close tolerance automatic check and closed curve
Combine lines: According to merger tolerance, auto-connecting curves.

Color map automatically switch to grayscale: Because under normal circumstances, graphics are based on

grayscale. If the imported bitmap is a color image can be converted to grayscale.

Import Dxf text message: When the user need only Dxf the graphic information, not need the text information
within the file, do not check this.

Export precision: The precision of export plt file or output file.

Velocity unit: Software supported two types of speed unit: mm/s. m/min. Selected according to usage. After it

was selected, the speed of parameters on the interface unit will change with it.

2.6 Basic graphics creation

File Parameter @ € Line

Import Setting /

PLT Precision: - Click menul Draw ]->[ Line ], or click Edit Bar ,drag the mouse
DXF Unit: MM v on the screen you can draw an arbitrary line. Press the “Ctrl” key
[J1mport Dxf text info while dragging the mouse to draw horizontal or vertical

[]smooth curves line.

Auto close curves

Close error(mm): (0.1

Combine lines
Combine error{mmy): |0.1 * Polyline

ket Click menu [ Draw ] ->[Polyline], or click Edit Bar - - Drag the

Export Precision(%): |80
mouse on the screen you

Velocity Unit: |mmjs |~ can draw an arbitrary polyline.

[ Ok ] [ Cancel ]

@ Rectangle
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Click menu [Draw] -> [Rectangle), or click Edit Bar - . Drag the mouse on the

screen you can draw an arbitrary size rectangle.

Press the “Ctrl” key while dragging the mouse to draw square.

@ Ellipse

Click menu [Draw] -> [Ellipse), or click Edit Bar . Drag the mouse on the screen

you can draw an arbitrary size ellipse.

Press the “Ctrl” key while dragging the mouse to draw round.

@ Point

Click menu [ Draw] -> [Ellipse], or click Edit Bar ¢ . Click the mouse on the screen, you can draw an point.

@ Text

A

Click menu [ Draw] -> [ Text), or click Edit Bar - And then in a drawing area any position click, pop-up

text input dialog box.

() TrueType Font: { T Tahoma v { wWidth: |50 o
O sHix font: &Y Fs.SHX Char space: ‘0 | mm
Text Line space: IU | mm
[T]Enable variable text
Height: _ 100 mm oK I [ Cancel ]

Choose font word, input text word, then set high , wide, word spacing, line spacing. Click again [OK] .
The software also supports variable text, the so-called variable text, the text is need according to certain

rules change, every output processing time, text to be automatic change again. For the system variables have
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character type date variables and serial number.

Variable is the date when the current every time processing take the current system of computer time
output. Software offers a variety of date format for customers to choose.

Users can also set the date migration, have the day by the month according to the years 3 kinds.

As in packaging carved on the expiration period can use the product.

() TrueType font: ‘ T Tahoma v] Width: \D %
(O 5HX font: i Fs.shi Char space: D mm

Text Line space: ﬁl mm

Enable variable text
TR
Prefix:
, [T]Enable 5M array
Suffix: ‘
Start 5N: |0000 Number Space ||
Current SN: EIUDD—| e [ ' l " ‘ =
—
==

Enable prefix ZERO

SN Inc: ﬁ l

v |1 o |

I_ OK ] [ Cancel

S

Height: 100 mm [ Apply ] [ OK ] [ Cancel ]

If ABCOOO1DEF processes repeatedly, ABCOO02DEF, ABCOO3DEF until ABC9999DEF a group of serial
number.

(® TrueType font: \ T Tahoma V! Width: @ %
(O SH Font: i Fs.shi Char space: ‘U—‘ mm

Text Line space: IU mm

Enable variable text

paeiidiiill s

12Hour[HH:MM][09:09]
12Hour[HH:MM][09:09:21]
24Hour[HH:MM][09:09]
24Hour[HH:MM][09:09:21]
American Date[02/07/2012]
Chinese Date[20125F02 A07 H]
Chinese Date Time[20125E02 B07
Chinese Time[098T0943:21%1]
European Date Time[07/02/2012a
European Date[07.02.2012]

Week Year[07/02/2012 09:09:21] +

N PR POV R QR T W 7, VR Re's |

Offsst:  |Day v|[0 $

Height: A100 mm [ Apply ] [ OK ] [ Cancel ]

(>
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[Prefix] : serial number prefix, example ABC is leading string.

[Suffix] : the serial number of the suffix, example DEF is the string after.

[ Start SN] : from which a specified number start manufacturing, example is to start to 0001 serial number.

[ Current SN'] : the current processing to which, serial Numbers, can also be used to specify the current to
processing which serial number. As in the processing a group of serial number, leakage processing the one, but
through the designated the current serial number to make processing, not set start, serial Numbers, because in
some cases a group of serial number requires repeated processing, namely to a serial number, need to go back
to the start serial number start manufacturing.

[SN Inc] : the interval number can be prescribed sequence number. Example will in turn processing from
0001 to 9999 serial number, the increment is 1.

If only need to output even or odd number serial number, can set incremental is 2.

[ Enable reset] : when serial number processing to reset the serial number, [ current SN'1  will be
automatically reset to [ start SN .

Example requires repeated processing from 0001 to 9999, serial Numbers, so can be designated 9999 as
reset, serial Numbers, when processing the 9999 serial number, text will automatically change to 0001.

[ Enable prefix ZERO] : if not lead to zero, the system will automatically remove the first in the serial
number of zero digital before the zero. Such as the example, serial Numbers, if not the leader's zero can
ABCO0001DEF will become ABCIDEF. But it is worth noting that, if we want to output serial number is
ABCI1DEF, ABC2DEF until ABC9999DEF, we can't through the will [ start SN]1 set to 1 to achieve, but
through the cancel [ Enable prefix ZERO] to achieve, this is because set in the specified number from the
start the serial number which one, beginning outside, also specifies the number of significant digits, such as
will begin to serial number set to 1, the change of the serial number order is: 1,2,3,4,5,6,7,8,9,0,1,2,3,4,5...
Serial number won't change to 10, because the effective a serial number had 1.

[ Enable SN array ] to the array of way, one-time processing more serial number.
for instance:

0001 0002 0003 after this batch processing serial number, 00150014 0013
0006 0005 0004 skip directly to the next group of 0007 0008 0009
0016 0017 0018 0016 0017 0018
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€ Capture

Click menu [Draw] -> [Capture), or click Edit Bar L
HedE ki X

HEES 1.0 (32-32) |

BiH

If the computer has been connected to the image device, the dialog box will appear. After it was selected,

you can collect the pictures from the specified device.

2.7 Object Selection
In the process of drawing and edit graphics,first of all is to select the object.
When the object is being selected,in the center of this object will have a shaped mark* x ”, and surrounded by

eight control points.

Click menul Draw ]->[ Select], or click Edit Bar R , switch to status“Select” . Under this status,you can select

object.The following are five kinds of method of selecting:
€ Click menu [Edit] -> [Select All] (Shortcuts Ctrl+A) , select all objects.

€ Click mouse on the screen to select single object

ag
4

00

@ Select object using select box
Press the mouse and drag, as long as the box come into contact with the object will be selected.
@ Increased select object/minus select object

Increase select: Press “Shift” key, click or box select to increase select object.

Minus select: Press “Shift” key, click or box select the selected object.
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@ Select object according to layer
BEEE

K B EE I
‘_tsizi’cﬂjﬁj 100000 30.000  Yes
I G ETE] 100,000 30.000 Yes
\ BYeETE] 100,000 30.000  Yes
TR 100000 30,000 Yes
[ :2E10E] 100,000 30.000 Yes
\
[

59/ | £
 t® | | TFE
Right-click the selected layer, then the part of all objects in the layer will be selected.

2.8 Objce Color

The color of object that is the color of the object contour.You can click the color button on the Layer Bar to

change the color of the object has been selected.The clolor of the pressed button is the color of current layer.

2.9 Object Transformation

Transformation of object mainly include: object location. orientation and size. But does not change the basic
shape of the object and its characteristics.

Transformation of object for users, provides a convenient user interface. User can mirror and rotation

Mh<sHE LD

through within the draw toolbar.

You can also use the Object Properties toolbar

% [445.91 | mm #[235.989 | | (100 l% 5 '
¥ (209,208 |mm § (208549 mm | (100 | a G b ] Process NO: 1

You can also use the right transformation tools to transform and copy the graphics.
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| Work | Output | Doc | User | Test | Transform

e
[+ o €| &) 2
Position:
H: ‘mm
\-“:1 ‘mm

2.9.1 Object Image

Object image is flip the selected object in the horizontal or vertical direction.

Click Edit Bar A » flip the selected object horizontal.

Click Edit Bar ™, flip the selected object vertical.
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| Work | Output | Doc | User | TesL] Transform |

Ratio:
H: | %
v: {}ou | %
Mirror:
d
[ pisproportionate
| A
O © 0O
O-0-"1
[ Apply to copy ]
| Apply ]

Or through the mirror to the transformation tools, horizontal and vertical mirror, and copy.

2.9.2 Object Rotate

Click Edit Bar > » will pop up the dialog of rotate angel setting.
Set rotate angle and click the button [OK] .

Rotate angle(deq) Ea |

[ Ok ] [ Cancel ]

If you want to drag rotation, set rotate angle 0,and determine.
Dragging the mouse to adjust the rotate angle, in the dragging process, there will be followed by rotating

wire-frame outline.
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A

/

i

Y

% [445.91 | m ¥ [235.989 | m | [100 | o _‘ B 0 i
¥ (299,208 | mm I[203.549Jmm 100 | o a @ G Process NO: |1

Or directly enter the rotation angle in the Object Properties toolbar.

' work f0utputrg Doc | User :j”Test ‘ Transfarm |

HIojis y

Rotate:
H: ‘0

e

Center:

v ]%00.?91 ’ i

[JLock rotate center
[Irelative center

A |dl_ |4
O © O
O-0-0

| Apply to copy |

| Apply J

Or use the spin rotation transformation tools to transform. In the rotations transformation tool can be set to the

center of rotation and locking center of rotation.

2.9.3 Object Size
% (445.91 |mm 9l (235.989 | mm | (100 | o 0 A
g o B Baecss] v | oo a @‘ v 0 Process NO: |1

You can set size and center position of the selected object.

44



;W-oirk output | Doc | User | Test | Transform |

Size:
H: |235.989 | mm

v 17203.549 1 rom

VD
[ [ [
o 0O
{= [Ee] 3]
[ Apply to copy J

,_.

Apply

Or use the size transformation toolbar to change the size of object. Can modify the size, choose whether to

lock the aspect ratio, and set the position relative to the object to transform.

2.9.4 Tilt

| Work | Output | Doc | User | Test ' Transform |

+ o] €| &z
Skew:
H: b 1 Deg
LE io ’ Deg
[ Apply to copy ]
[ Apply ]
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Object can be tilted by the tilting transformation tools. It can be set the tilt anchor and the tilt angle.
The tilt will cause distortion of the bitmap and the practical application of small, currently only supports

the tilt vector graphics.

2.9.5 Object Array Replication

oo
Click Edit Bar Ik » select object wants to copy. Then click OO, the following dialog box appears:

Array copy @

XMum: 1 | ¥Space: 0.000 |
_'ﬁ‘ ;Tm'| oo
Yhurm: | | YSpace: (0.000 | |‘ooa
Cancel Ok
H wig . . | . .
idth of a single graphic(mm) Height of a single graphic(mm)

You can array replication object along different directions.The direction of copy is based on the orginal
graphics.Such as choose the array direction lower right,then the original graphic will appear on the upper left

corner.wheras if it is to the upper left array,then the original graph appears in the lower right.

After setting the array number and array spacing, click button [ Apply] ,you can see the actual graphics
array.
There are two forms of array spacing: center spacing and edge spacing.
Choose center spacing, thenl X Distance(mm) J.['Y Distance(mm) Jrepresenting the distance of the two graphic
center.
If not choose center spacing,then [ X Distance(mm) ). [Y Distance(mm) ] representing the distance of the
graphic edge.
Center distance X = Edge distance X + width of object
Center distanceY = Edge distance Y + height of object
Switch between the two kinds of calculate method, [X Distance(mm) ). ['Y Distance(mm) Jwill be calculated
automatically.
Click [Bestrewing breadth), The software will automatically calculate the array number
according to the workpiece sie. width. height. X distance and Y distance.
Adjust spacing can be directly input values,and click [Apply]
Can also press the dirction keys to adjust objects spacing.
Check [Center] ,then after object array replication,graphics will be centered on the work area.
Scroll the mouse wheel to zoom view of the graphics.

Drag the mouse to pan view of the graphics.
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2.9.6 Place Object To The Origin

Place the object is to facilitate the view or orientation. The following tools are provided by software:
a4
center of the page.

N 21N e

left corner of the object, upper right, lower right, lower left and upper left corner, top right, bottom right,

, selected object will be placed in the center of the page, that is the object center coincides with the

, Selected object will be placed on the page left, upper right, lower right, lower left, upper

bottom left corner of coincidence.

2.10 Object Align

2SN R0 HxES08

Select objects, click tools on the Align Bar =

Whick include:

O O
2 & 0 Left alignment. Right alignment. Top alignment. Bottom alignment

ov 52 [

Vertical center alignment. Horizontal center alignment. center alignment

I5E 25

Horizontal equidistance. Vertical equidistance

=0 =

Same width. Same height. Same size.

Benchmark object:
If you press “Shift”’key and select object one by one,zhen the benchmark object is the last object.

If you select object by select box,then zhe benchmark object is the object which curve number in the final.

2.11 Object View

+
Move: Click menul Edit]->[Movel, or click “ . Then hold down the left mouse button in the drawing area,

and drag pan.

Zoom Out: Click menu [Edit] > [ZoomOut]), or click * o Each click it, the drawing area zoom out

once.Move mouse to the drawing area and click,each click,mouse position as center drawing area zoom out

once.

Zoom In: Click menu [Edit] -> [ZoomIn]), or click . Each click it, the drawing area zoom in once.Move

mouse to the drawing area and click,each click,mouse position as center drawing area zoom in once .

View Select: Click menu [Edit] -> [ View Select], orclick =*. Move the mouse to the drawing area,hold

down the left mouse button and drag, a dash border box will show in the drawing area,release mouse button,
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then the region in the dash border box will display in the drawing area with the largest proportion.

View Page Frame: Click menu [Edit] -> [ View Page Frame], or click ", The page frame will full display.

View Data Frame: Click menul Edit]->[ View Data Frame ], or click R - The selected objects will full display

2.12 Group and UnGroup

Edit graphics, and sometimes need to be a part of the operation as a whole (such as multi-line text layout).
Method: Select the group of graphics, and then select the menu [Edit] / [Group) ( [UnGroup] ), or

directly select the toolbar o |

2.13 Important Tool

Here are some frequently used tools. Using these important tools, can make the current document in the

graphics more orderly, and make the processing of output more fast.

2.13.1 Manual sorting and the set of cutting point and the cutting direction

Software provides users a convenient tool for the manual sorting. Select [Edit]-> [ Set cutting property 1.
Cutting property dialog box will pop up. All with manual sorting, and cut points, cutting the direction of the
settings in this dialog box can be completed.
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Set cutting property E]

[ ReOrder J L Reverse J [ ReOrder

| NO Name AN | no Name
Element1
Element2
Element3 |
Element4
ElementS
Element6
Element?
Elementd
Elementd
|10 Element10
11 Element11
| 12 Element12
13 Element13
| 14 Element14
15 Element15
16 Element16
17 Element17
18 Element18

> 22 S 19 Element1d [
Q . | 20 Elementzo >3
v i v 21 Element21 [
. @ |22 Elementzz | [e<
e— - 23 Element23 |

Ny 27 Y 24 Element24
4 ’ : 25 Element25

Ty 2 | 26 Elementze
Q 27 Element27
)i L 28 Element28
; s 29 Element29
) 2 30 Element30 Y
>

‘;ShowPath | l, L,
XIS

0N R W N

Show path

First check the “show path”, it will display the current graphics cutting order and the cutting direction.

Manual sort

Select . This button is used to switch the current status of the operation is to edit or view. Then you can

marquee or click the graphics in the graphics display area (or click one pixel or check many pixels). After

primitive. Primitives followed by repeated operations, to complete sequencing of all graphics.

selecting the graphic, select , these graphics to be redirected to another list, to be processed as the first

Change the direction of graphic processing

Mouse select the graphic in the graphics display area or in the list. And then click .

Change the cutting point
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Set cutting property @

[ ReOrder }[ Reverse ] [ ReOrder J

NO | Mame o NO  MName |
Element1
Element2
Element3
Element4
ElementS
Elementé
Element?
Elements
Elementd
10 Element10
11 Element11
12 Element12
13 Element13
14 Element14
15 Element15
16 Element16
17 Element17
18 Element18
19 Element19
20 Element20 | [>7
21 Element21
22 Element22 << <
23 Element23
24 Element24
25 Element25
26 Element26
27 Element27
28 Element2s
29 Element29
30 Element30 ¥
|

[¥] showpath _ﬂ__] L‘
i X H]

Select the graphics that should be changed the cutting point, it will show all the nodes in the current

=0 = T, RN R N SR

graphics. Select the starting point, double-click the mouse, it will change the starting point of the current

graphics. After the completion of all changes, click , the result of the changes can be saved.

In addition to cutting property features, the software also offers some tools to change the cutting order,

cutting direction and cutting point.

Select ‘Q in the toolbar, or click the menu command [Edit] -> [ Show Path] .
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File(E) Edit(E) Draw(D)  Config(S) Handie(W) View(y) Help(H)
DEEH dH oa CRQAAAR ([Oedd ~Mw it o B % &
% [340.264] o [ [100 [100 ] o ] ]
g mio. dE O !

10

work |output | Doc | User | Test | Transform

Layer = Mode Speed  Power Output
B Cut 100000 30.000  Yes

v
6
K
7
|
/\,.EE
gl
).
Al
. o]
glﬁ{ < >
x : Up Down
_: Device
& = Find Com Auto v/
23]
B
= Position: [ current positic v |
= _: Go scale Cut scale
O

SaveTolFile UFileOutput

g g ? [[J output select graphics
I g Path optimize
=] ¥ ¥
o Previous work time) [oH:0M:05:0M |

—— #Helcome to use the Laser system of cutting Propose the display area 1024#768 or higher *-—— X:B05. 135nm, ¥:313. 460nm

Manual sort
Choose the primitive that should be changed the cutting order, then the cutting serial number of the current

primitive will display in the object properties bar.

X 701,941 |mm ¥ 179.859 | mm 100 | e, E’ — S -
[ prpyrp— r — il Process NO: (17
¥ [243.79 [mm § [e3.862 [mm | (100 | o = G b J

IS (X el s>002N\\|AZ

s60.0] s800] 600 0] 6200 6401
RTRA i i

60 1) 6200 7000 720” 740 0) 7600 7300 3000 3.
[RRRA K M KRRRA N

R o 200 IO o ATEE) L ST, R K RO vt it HYAPEN Fhciri o RT Mo AT

00D, POODG) L RO RAOD o BOODE

Enter

the serial number directly in the processing number, then press the keyboard “Enter” key, or click the plot area,

the cutting order will be changed.

Change the processing direction
Click [Edit)] -> [ Set cut direction] , to enter the edit mode of the cutting direction. Then you can double-click

on any position on the selected graphic.

Change the cutting point
Click [Edit] -> [Set cut point] , to enter the edit mode of the cutting point. Then select the curve that should

be edited, you can double-click on the node that you want to set the cutting point to complete the change of the
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cutting point.

2.13.2 Setting And Editing The Cut In/Cut Out Lines
Drawing or importing curves, the curve is default not have any cut in/cut out lines.

If want to add cut in/cut out lines,select the objects, then click [ Edit] -> [ Edit cut in property ],

click © .The following dialog box is appear.

Cut in and out setting @

Cut in
Enable
Line type: ! Line: 1
\
Lenagth{mm): \ ‘
‘With angle v
r
Angle{degree):| ‘
Cut out
Enable
LineType:
Length(mm)
(3) Female
O Male

[ Ok J[ Cancel ]

To make cut in/cut out lines, first of all need to enable the cut-in/cut out function.

There are two types of the cut in/cut out lines: straight line and arc

Straight line cut in achieve through three ways:
Cut in with angle: cut in line and starting segment into a certain angle, counterclockwise angle is positive
Cut in at center, the starting point of the cut in line is at center.

Cut in from center, the direction of the cut in line is from center to starting point, and length is as setting.
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Cut out line

Cut in line x

The arc length of cut in arc is as setting.

There are two types of cut in/cut out arc, as shown in the following figure

Female Male

The processing of setting cut out lines is same as cut in lines.

2.13.3 Path Optimization
Path optimization is primarily to re-order the vector graphics.

o
Click menu [Handle] > [ Cut optimize], or click ® % ,the following dialog box is appears.

Cutting optimize handle @

[Jorder of layer

Inside to outside

(e
| Single inner to outer v

Block handle

Height: |57 ‘ Dir: |Up to bott +

—

[]start point optimize
Auto determine start point and direction

I Ok ] [ Cancel ]
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Click menu [Edit] -> [Show Path], or click ‘E, can see the cutting path before and after processing.

Laser head

Before processing After processing
Graphics cutting path is always starting from the laser head.

2.13.4 Curve Smooth

For some less accuracy curves, this function can make curves more smoothness, and processing smoother.

Click menu [Handle] -> [Curve Smooth], or click ™| the following dialog box appears.

Curves smooth

Smoothness I 9% [[Ipirect smooth

l [_Apnly ][FullFrame][ Ok ][ Cancel ]
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Drag the smooth slider, and click button [ Apply), before smooth and after smooth curves will all show in the
dialog.

The black curves represent the original curves, and the red curves represent after smooth curves.

Curves smooth @

Smoothness J 95% |:]Direct smooth

I I [ Apply ][FullFrameH Ok ][ Cancel ]

You can view the graphics with drag mouse.

You can zoom in/zoom out the graphics with scroll wheel.

Click button [FullFrame), graphics will shown in the dialog box for largest.

After get satisfied smoothing effect, click button [ Applyl, curves will processing smooth according to
smoothness settings.

Select “Direct smooth” , you can use another smoothing method.

The choice of smoothing method should be changed with the needs of the actual graphic.

2.13.5 Check Closure

[l ,the following dialog box appears.

Setting close error @

Close error (mm): l:'l] J

Click menu [Handle] -> [ Curve auto close], or click System Bar

Force to close

Cunce

Close error: When distance from the starting point to ending point less than close tolerance, automatic closing

of the curve.

Force to close: Mandatory closure of all selected curves.
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2.13.6 Remove The Overlap

Click menu [Handle] -> [Delete overlap] ,or click = , the dialog box appear.

Delete overlap lines @

[]Enable Overlap error
Overlap error{mm); : |

[ ok | [ Cancel ]

Under normal circumstances do not select the “Enable Overlap error”. Removing the overlapping lines
when two lines are compared to a good degree of coincidence. If you need to delete overlapping lines, you
should select “Enable Overlap error”, and set overlap error. Generally do not overlap error set too large, so as to

avoid accidental deletion.

2.13.7 Combine Curve

)
Click menu [Handle] / [Combine Curvel, or click =t ,the following dialog box appears.

Setting combine error @

Combine error{mm): [rl

[ Ok ] [ Cancel ]

The software automatically merge curves in the selected curves, when these curves merge tolerance is less than

the setting of combine error.

2.13.8 Bitmap Handle

Click k , and select a bitmap, then click menu [Handle] -> [Bitmap handle] , or click System Bar S
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Bitmap handle [z]

Width: 501 Pixels
Height: 750 Pixels
H Resolution: 96 Pixelsfinch
V¥ Resolution: 96 Pixelsfinch
Brightness: 0.0%
-
3
Contrast: 0.0%
2
[Jinvert color
[ 5et output resolution
Resolution{pixelsfinch)
[CIpither

Met graphic

[rizEs)

Black And White

[ Apply to view ] [ Apply to source ]

[ Get outline ]

| |[Saveas ”FuIIScreen][ Ok “ Cancel ]

In the top right of the dialog box displays the information of the current image.
Be noted that, the horizontal resolution and vertical resolution is changing with drag scaling.

[ Apply to view ]: Current settings is only used for preview, without affecting to the original bitmap, press
button [ Cancel ], bitmap will returned to the state of original image. Therefore, only use for adjust effect.
However, this approach requires more time and memory Space.

[ Apply to source): Current sttings is use for orginal bitmap directly, so even finally click button [ Cancel],
image will also unable to return to the original image. Therefore, it mainly used in multi-step operation, and the
current operation of this step is necessary to do, such as general pictures must be transformed into grayscale.
This can save the computing time of the follow-up operation.

[ Save as]: Retain the results of the previous operation, In addition to using [ Apply to view ] can also be
exported. On this basic, to facilitate subsequent processing.

[ Gray scale] Generally, other image processing is based on the grayscale, so before handling, you can do a
grayscale processing, then click button [ Apply to source ] For the grayscale than the color image occupied
smaller memory, for large image step by step handle, to a certain extent to avoid the lack of memory.

For color image, adjust contrast and brightness, have some auxiliary effect to following dither processing.

Adjust contrast:




Before processing After processing

Invert:

Sharp:

A7 X8 www.01w com

Before processing After processing

There are three method for dither processing: Net graphic. Dot graphic. Black and white

Net graphic

Net graphic need adjust net size, better suited to material which is not high resolution, or the laser is relatively
slow to respond.

To get the appropriate net size, you can adjust resolution and net frequency of the image.

The higher resolution, the more delicate.

The higher net frequency,the smaller net size.The lower net frequency, the bigger net size.

Generally, resolution of image is 500 - 1000, and net frequency is 30-40lines.




Dot graphic

Dot graphic performance of good grayscale, better suited to material which is high resolution, and the laser

responds fast.

Black and white
In most cases, the effects of color image into black and white image is poor,, however, for some clear outline

image, is very easy to use.

RN ELFS RN

Get outline:
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Bitmap handle

[ pither

Width: Pixels
Height: Pixels
H Resolution: Pixelsfinch
¥ Resolution: Pixelsfinch
Brightness: 0.0%
-
3
Contrast: 0.0%
J (zze]
[invert color
["] set output resolution

=
Resolution(pixelsfinch) |“°

[ Apply to view

] ’ Apply to source ]

I Get outline

]

I I [ Save as “FuIIScreen“ Ol

k[ cancel |

Click “Get outline” button to extract the contour graph. As following picture

=]
SR

2.13.9 Processing preview

Click menu [Edit] -> [Preview] , or click System Bar 2
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S

sice

ok tine
Light time
T it
Hork tarva

Position 0.0mm,0.0mm
mmnnmm__

Progress

Default ~ )

Simulate

-
=3
(=3

Simulation [ Pause/Continue " Stop

Software supports the preview of the documents to be processed, and you can get some basic information
through the preview. For example, the path of the actual output of the processing, general processing time,
processing the distance. The machining process can be simulated.

In addition to the current edited file preview, you can also preview the files have been saved as rd.

Preview rd file:
Double-click in the graphics display area. Choose the graphic you want to preview in the pop-up dialog box.
And then open

Look in: | (L) My Documents v o P

() Adobe Scripts ‘;IMY eBooks ) Source Insight

\)Baidu My ISO Files \_)Visual Studio 2008

) Corel User Files My Music ) FANN N

(_JFILTERiT4 User Settings ;', My Pictures

JKSDStore DMy QQ Files

)My Designs @]1my webs

< >

Files of type: | *.1d v
[] Dpen as read-only

Software also supports to set the parameters of preview
Right-click Anywhere in the graphics display area, the configuration menu will appears.
Select “Config” , pop-up following dialog box
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Full window Configuration @

Confi
£ Background
Horizontal mirror Back color: . Font color: .

Vertical mirror

Draw color{Power)

oo [ | [ W o
Simulate color{(Power)

oo [ O W o
Idle color .

Anchor

() Top left () Top right
() Bottom left () Bottom right

You can preview the color of graphics to match the actual output of energy. Users can easily view whether
the layer energy is true.

2.13.10 Data check
Selected to check after the graphics, click on the menu commands [Handle] / [data check 1 , or click

system toolbar E .

Data check @

Close check end
,,CheCk close Mot find unclose curves
E Self-cross check end
[auto close Error(mm): {:l Mot find self-cross curves
Cross check end
Check self-cross Mot find cross curves
Overlap check end
Mot find overlap lines
Check cross
Check overlap
[JEnable error Error{mm): |00 i Check

Data check, integration of the closed inspection, the inspection, the inspection, the intersection of the
fellowship data overlap a check. The user can select a check, inspection to the problem after data, will be in the
dialog box right tip have been found and, at the same time, the problem in selected state graphics. Check->
ruled out repeatedly error-> inspection process until all the data are conform to the requirements of the

processing.
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2.13.11 Generation parallel lines
Selected to create parallel lines after the data, click on the menu commands the [Handle] /[ Offset poly], or

click system toolbar = .
A .
R RRRRRRERRRRRBBBRBRRRRRRRRRRRRR // \ lf \\,‘
Offset poly —~ A K \ N
<— (O™ —>
~ T w &
OFfset(mm): 0.1 mm []Delete artwork 7o ] ( > o 5
®1In Cout () auto Injout > -’
L~ / > A
// // ‘K A A i N \\
/ /’ ‘ /\\ ’\\ l \\ \\
Ok l [ Cancel ] ( Lx] L\ / N A

Red line in the figure for the original graphics, green line is inside shrink graphics.

2.13.12 LGP design

Click the menu commands the [edit] / [LGP design 1 , or click drawing toolbar, already can start reflex
block design tools, the tools are specific to block the sun processing, is an independent functions, such as the
user is not involved in the sun block can be ignored this section processing content.
Play channel tabula rasa design tools, we first need to design a reflex guide the outline.Play channel tabula rasa

design tools, we first need to design a reflex guide the outline

LGP CADSCAN System
Parameter | Output | System

LGP Size(mm):

Widkh: [200.000 | reghts [200.000

Lockratio

Apply

[JEnable LGP blank

[l

Create LGP outline
width; | 200 Height: |200.0

() Rectangle OElipse

[ stat J[pauseicontinve ][ stop |

[_saveurie ][ outputurie ][ pownload |

[ cosede_J[_cotode_J[_rovew )

Play channel tabula rasa design tools, we first need to design a reflex guide the outline.

In the tool, the default created a 200 X200 rectangular guide tabula rasa outline. The user can in the tools of
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"system" page manually create a standard to the shape of the guide tabula rasa outline.

Create standard setting the outline can use rectangular or oval.

The user can also import a has good graphic design, as the outline of the sun. Click on the "introduction to
guide tabula rasa contour" button, can choose to have the outline of the document as the sun. Need to point out

that outline file must be closed graphics, otherwise, the system will automatically deleted.

LGP CADACAN System

Paraneter | Output | Systen

)

18.1 Height: [200.0

tio
Apply.

[JEnable LGP blank.

(=5

Create LGP outine
Width; [200.0 Height; 200-0

@Rectangel OFlipse

Forly

Import artwork

LGP Size(mm): Create LGP outline
Width: |218.1 Height: |200.0 width: [200.0 sy 200.0
Lock ratio ,._ )
[ Apply (U Rectangle (¥) Ellipse
L Apply ]
[CJEnable LGP blank
[ Import artwork, ]

)

If the outline of import size requirements, users can also change size outline, and can set up if stay white
edge.

Outline graphics ready, they can start on the tabula rasa increase network.
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LGP Paint{mm})

LGP type: »Grid v
Width: ] Height: 37
UpGrad: | ‘ UpGrad: '
DownGrad: | | DownGrad: |
LeftGrad: [ LeftGrad:
RightGrad: RightGrad: |
Space{mm)
Up: [2.0000 | Grad: [0.2000
Down: (20000 | Grad; |0.2000
e 2.0000 Grad: |0-2000
Right: (20000 | Grad: |0.2000
Base line

Zero

¥ |0.000 ' v: |0.000

Enable row and colown

EnRow EnColumn
Light source
[Left [Iright
[J1op [IBattom
[ Apply ]

Network is divided into four ways: straight line, elliptical, rectangle and the grid.

Network is divided into four ways: straight line, elliptical, rectangle and the grid.

Baseline related with light source, the user can adjust the baseline position according to time light source.
In the figure above red graticule marker is the baseline, users can move the mouse to baseline, press the mouse,
and then drag the baseline to want to position.

The entire guide baseline reflex is divided into four regions, level above baseline definition for uplink and
downlink below defined as; Vertical baseline definition for the left column on the left, the right to define right
column.

Set respectively size and spacing network respectively in up, down, left column, the right column initial
value and the gradient of the change, can form users want to conducting tabula rasa effect.

For grid way, must set exercise can/column that can, can appear the grid.

For the convenience of application, the system to provide the light setup, if the light source is a standard,
can choose the light source, then set the network parameters can be, do not need to adjust the baseline. At this

time, baseline shows hides also.
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Grid way Elliptic way

Left light source Right light source

Top Light source Bottom light source

R e
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LGP cut/Engrave

Speed(mm/s): }[100.0 jl:]DefauIt
MinPower(%): i30.0 ;[]Defauk
MaxPower(%): ‘30.0 '
"Is e ol
Scan precision %1016 | dpi Line, elliptical, rectangular way is the network scanning mode
D ‘ 0.000 ;ms of output.
‘, f Scanning mode, the minimum energy, maximum energy
OffDelay: ‘0'000 fI0= general is same, and dedication of the delay is 0. By adjusting
Outline cut the scanning system precision, to adjust the scanning of the
[ ]Enable outline cutting density, the more accurately the scanning scan line secret,
‘ } scanning the lower accuracy the scan lines sparse.
Speed(mm/s): ‘ | The grid processing methods is cutting, and scanning not
MinPower(%): ‘ efault precision, and can be adjusted according to the actual effect,
MaxPower(%): | 0 ’ the maximum and minimum energy energy light switch delay,
‘ generally speaking, the least energy slightly lower than the
; } maximum energy.
OnDelay: \ | ms If need to cut the reflex the outline, make can contour
OffDelay: \ | ms cutting. About cutting parameters and common cutting Settings

identical, in hereby here.
Array parameters . .
If need to press array in the way processing more panels,

: (1 | . [0.000 | ssing
e —_— oRaes: Lii,, ‘ can be set to array parameters;, Array direction along the
Yhumi |1 | ¥ Space: |0.000 ‘ machine is always the origin in the opposite direction.
[ USB:Auto ]
Position: fCurrent Position 7v7

[ Start J [Pause,fContinueJ[ Stop ]

[ SavelJFile ][ QutputUFile ][ Download J

[ GoScale ][ CutScale ][ Preview J

67



Chapter 3 System Settings

Before output graphics, required to determine whether the system settings are correct.Click menu [ Config] ->

Config(S) | Handle(W)  View(yV

Systern Setting
File Para Setting

[ System Setting]

Page Setting
Password Setting ]

Graph Hatch
Show Array
Show grid

3.1General settings

Setting

General settings | System Info
Axis Mirror Laser head
[ axis % mirror ® O O
©C O O
Axis ¥ Mirror O O O [] absolute coordinate
Small circle speed limit Scanning{Reverse interyval)
Diameter{mm) Speed{mmjs) Speed{mm/s) Reverse intery...
< | > < >
| add.. | [ Delete | [ add.. | | pe |

Axis Mirror
Generally, Axis direction of mirror is based on the actual location of the limit or home of machine.
The default coordinate system if Descartes coordinate system, and zero in the bottom left.
If the zero point of the machine is top left, then X-Axis do not need to mirror, but Y-Axis need to mirror.
If the zero point of the machine is top right, then both X-Axis and Y-Axis are all need to mirror.

In addition, this function can also use to other application for mirror.
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Default — RD5.0.0.9
File(E) Edit(E) Draw(D) Config(S) Handle(w)  View(y) Help(H)
wl AR eratReeas Do YwdsidHo 8% H
mm \; o | [100 ] «
= B rm ﬂ‘ !

EEZ IR

;UE

L T . T

EEE

work | output | Doc | User | Test | Transform |

O

e

o

ICREBAEIX0 +>002 N\ |AF|<x

s

RIwmeg <isl@rANoNEEND NEEEEE D SEELN

Layer | Mode | Speed | Power  Output

B3
Device
Cro—
Laser work.
Position: | Current positic ¥
[ Goscale | [ cutscae |

pEscains
SaveToUFie UFileOutput

[ output select graphics
Path optimize

[revious work time oH:ont:os:oms ‘

—— xfelcome to use the Laser system of cutting Propose the display area 1024#768 or higher *——— X:773. 957mm, Y:284. 576nm

Laser head

Position of Laser head means the location laser head relative to the graphic.

Top Left Top Middle

Middle Left Center
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Bottom Left Bottom Middle Bottom Right

when you intuitive view, just look at the zone where the green point appears.

Absolute Coordinate

You can directly check this option when you want the graphics location in the graphics display area correspond

to the actual work location of processing. Then the graph position will no longer relate with the actual output
position of the laser head and orientation point, but always regard mechanical origin as the anchor point.
Small Circle Speed Limit
On processing work, the software automatically determine whether the current round need to limit speed ,then
according to the diameter size of the circle to determine the speed. If parameter configuration appropriate ,will
greatly enhance the quality of small round. Click button [Add), [Delete] , [Modify] to configuration.

Small circle is less than speed of the rules limiting the list of small round circle of minimum radius,
minimum radius circle at the speed of the output of the corresponding.

If the speed greater than maximum speed limit list the speed round, the speed only associated with the
speed of the layer.

If the speed is in the list, set the output speed by list.

If the request received by limiting layer parameters faster than the speed set in the layer, press the speed of
the output layer.
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Scan backlash

Laser scanning graphic way, because the relationship between the machine belt tension may cause the
edge of the scanned graphics uneven. Therefore, increasing backlash to fix. It has the specific backlash for the
certain speed. General, the greater the speed, the greater the backlash.
(D Add backlash

Click the Add button, the screen will pop up as shown in Figure

Speed(mm/s) [ ‘

Reverse interval(mm)

Set speed and backlash, click OK, the value to be inserted into the list of backlash.
2 Modify backlash
Double-click the left mouse button scanning (reverse gap) need to modify the reverse block entry

clearance, then the pop-up screen shown in Figure.

Reverse interval(mm) 1‘0.4 ‘

t Ok | [ Cancel ]

In the interface can modify the current speed of the corresponding backlash.

(3 Remove backlash
Right-click scanning (reverse gap) block in the backlash to delete the item, then click the [ Delete ] button.
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3.2 System info

Setting

| General settings | System Info |

Vendor password: ' [ Input ]

Mainboard version:

Close

Information on the operation of the motherboard manufacturers need to enter password to view parameters.

Setting

| General settings | System Info |

Total on time(hour:min:s): |

Total processing time(hour:min:s): |

Previous processing time(hour:min:s:ms): |

Total laser on time{hour:min:s):

Total processing times:

¥ Total traval(m):

Y Total travel(m):

Mainboard version:

“ Upgrade |

Total on time: The total time of motherboard working
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Total processing time: The total time of processing ,including the time of jump moving.

Previous processing time: The time of the last processing

Total laser on time: The time of the laser processing

Total processing times: The number of completed processing, not include the processing forcing to end.
X total travel: The total travel of motor X.

Y total travel: The total travel of motor Y.

Motherboard version: The version of the current controller.

The function of upgrades:
If the board has additional features, the manufacturers will provide the update file  (*. bin format), the
user can load the upgrade file to upgrade the motherboard. After the upgrade, you need to click on the control

panel "Reset" button reset the motherboard before normal use.

3.3 User parameters

AWorkﬁ_ Output | Doc 7 User | Test Iransfoim_r

;E] Cut parameters b
Idle speed(mm/s) 300.000

Idle Acc(mmjfs2) 2000.000

Start speed(mm/s) 15.000

Min Acc({rmm/s2) 500.000

Max Acc(mm/fs2) 2000.000
Cutting mode Norral Cutting
Acc Mode S mode

Sweep parameters
¥ Start Speed(mmjfs) 20.000
y Start Speed(mm/fs) 15.000

¥ Acc(mmyfs2) 8000.000
y Acc{mmyfs2) 2000.000
Line Shift Speed (mm, 150,000
Scan Mode Common Mode
Facula Size(50~99%) 93,000
'E Home para
Home speedimm/s)  80.000
Auto home X Yes
Auto home Y Yes
Auto home z No
0 b Vi 1) nin bl

[

Reading the board parameters must before operating the user parameters.
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3.3.1 Cut parameters

H= cut parameters
Idle speed(mm/s) 300.000
Idle Acc(mmjfs2) 2000.000
Start speed(mm;/s) 15.000

Min Acci{mm/s2) 500.000

Max Accirmm/s2) 2000.000
Cutting mode Norral Cutting
Acc Mode S mode

Idle speed: this parameter decides the max. speed of all lines not emitting beams during the operation of the
machine. This parameter should not be lower than the lower of the jump-off speed of the X-axis and that of the
Y-axis and not exceed the higher of the max. speed of the X-axis and that of the Y-axis, if the setting is illegal,
the controller will automatically set this parameter within the range above; a comparatively high idling speed
can shorten the operation time of the entire figure while excessively high idling speed may cause dithering of
the tracks, therefore, you should take all relevant factors into consideration when setting.

Idle Acc: Corresponds to the acceleration of the speed of air travel time, air and air-way-way speed of
acceleration to match, if you set too slow the actual speed may not reach the air-way set value, if set too fast,
they may not withstand the mechanical structure, resulting jitter . Slightly higher than the general acceleration
of air-way cut acceleration.

Cutting Acc: Corresponding to the acceleration of the speed of cutting (cutting speed is the speed of the layer
parameters of the layers).

Turning speed: Turning the corresponding deceleration in the cutting process, the minimum speed of the drop,
when processing a lot of teeth when the graphics may be appropriate to reduce the turning speed.

Turning Acc: Should match with the turning velocity.

Cutting mode: Split precision cutting, fast cutting, ultra-fast cutting, the user can choose according to the actual
applications. Such as the emphasis on accuracy, select the precision cutting, such as emphasizing speed, select
the fast cutting.

Acce. mode: this parameter decides the acceleration and deceleration mode (S mode or T mode) of the motor
during operation, the motor accelerates and decelerates slowly and smoothly in the S mode and fast and

relatively unsmooth in the T mode; the default mode is the S mode.
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3.3.2 Sweep parameters

= Sweep parameters
¥ Start Speed(mms) 20.000
y Start Speed(mm,s) 15.000

¥ Acc(mmyfs2) 2000.000

y Acc(mmyfs2) 2000.000

Line Shift Speed (mm, 150.000

Scan Mode Common Mode

Facula Size(S0~99%) 98.000
x Start Speed, y Start Speed: Off scanning speed in the use of stepper motor drag, do not began to

accelerate from 0, but can start work directly from a speed to shorten the overall processing time, but the speed
is not too high, and because the X, Y axial load is different from the rate, general the initial speed of X-axis
slightly higher than the initial speed of Y-axis

x Acc, y Acc: With the scanning speed (the speed of layers in the layer parameters) to match, if set too
small, the scan speed to a longer distance, the scanning efficiency. The machine can be set according to the
actual structure, load conditions vary. Since X, Y axis load, generally much higher than the X-axis Y-axis
accelerometer.

Line shift speed of scanning: this parameter is specially used to control the max. speed of the scanning to
shift vertically from one line to the next line below it. If during the scanning, the line space is too large or the
block space is too large when scanning block figures while precise positioning for each line or block is required,
you can set the line shirt speed of scanning to a comparatively low value. This parameter cannot be less than
the jump-off speed of the corresponding axis during the line shift and cannot be higher than the max. speed of
the corresponding axis during the line shift, if the setting is illegal, the controller will automatically set this
parameter within the range above.

Scan mode: There are two modes for your selection: the general mode and the special mode, in the general
mode, there’s no any treatment during the scan, in the special mode, light spots will be treated. If the special
mode is activated, the power of the laser should be increased and correspondingly, the light spot percentage will
be lower and the laser power attenuation will be higher, to achieve the same depth of scanning, the laser power
should be higher. The purpose to select the special mode is to make the laser to emit beams at high power and
in short period, during deep scanning, the effect of flat bottom
can be achieved, however, if the light spots are improperly adjusted, this effect may not be achieved and the
working mode of high power and short period may influence the service life of the laser. The default mode is
the general mode.

Facula Size: When scanning the general pattern of selection, the argument is invalid, when you select a special

mode, the onset of the parameters. Control the parameters of control in 50% to 99%, respectively.
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3.3.3 Home parameters

=] Home para
Home speed(mm/fs)  80.000
Auto home X Yes
Auto home Y Yes
Auto home z No
Auto home U No

Home speed: This parameter determines the machine is turned back to the origin when the speed of a
larger format if the machine can be set to reset the speed is too large, but not too much.
X,Y, Z, U Auto home: The axis can be set whether should reset at boot time.

3.3.4 Go Scale parameters
= Go Scale para
Go scale mode Close laser
Go scale blank{mm)  0.000
Go scale mode: Points of light to go off the border, the opening cut borders, corners three modes.
Go scale blank: Walking frame can be based on the actual image size up and down again about the
direction of some of the white left side of the border in order to ensure complete contains the actual graphics.
This setting is on the control panel to go with the border-related functions, while walking on the border

with the independent software.

3.3.5 Other parameters
= other parameters
Array processing Bi-dir Array
Return position Absolute Origin
Delay before feed(s) 0.000
Dealy after feed{ms) 0.000
Focus depth(mm) 0.000
Backlash X({mm) 0.000
Backlash ¥ (rmm) 0.000

Array mode: you can choose the swing mode and the one-way mode. The Swing mode: cutting the array back
and forth in order; the One-way mode: always cutting the array from one direction to another. If One-way mode
is selected, all array units have the same movement modes and the same liquidity of movement, however, this
mode will take more time than the swing mode. The default mode is the Swing mode.

Return position: You can select the locating point and the machine origin. This parameter decides the position,
the locating point or the machine origin, where the laser head stops upon completion of each operation.

Delay before feed: Using the feeding device, the delay before a single feed, users can arrange the time and the
like, such as picking process.

Delay after feed: Refers to the material sent to the feed device in place, the need for stability after a period of
time for processing.

Focus depth: Auto focus operation to find the corresponding panel.

Backlash X, Y: Used to compensate the backlash caused by the machine drive problems.
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3.4 Document Management

7 \Work | Output | Doc | User || Test Transformr

| Number File Mame Time{H:M:5:MS)

[ Read [ Process ][ Download ]

]
[ Delete J[ Delete Al J[ Cal time: ]

Read
Click button Read, the software will communications with the controller, read the list of files on the controller.

After read controller successful ,file information will be displayed in the document list.

Download
Click button Download , will pop up the file dialog , select *.rd downloaded file, then the file will be
downloaded to the controller.

If the download is successful, the document list will update.

Process
Select the file to be processed from the document list ,and click button Process

The controller will start the specified document.

Delete
Select the file you want to delete from the document list, and click button Delete
The controller will delete the specified document.

If the deletion is successful ,the document list will be updated.

Delete All

Automatically remove all file in the controller, and update the document list.
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Cal time

Motherboard supports processing files towards hours worked. Select the file to calculate the work hours
worked and click the button. Calculation to be completed, the control panel will be prompted to complete the
calculation. And then point to read button shown in the list, calculated from the working hours.

In addition, when the document processing operation performed, the hours information will also be

covered by the actual processing work.

uploading

On the main board of the selected from read offline files, and saved to the computer.
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Chapter 4 Processing Qutput

X

Laser work

Processing control
[ Start ][ Pause/Continue ][ Stop ‘T/

[ SaveToUFile ][ UFileQutput ][ Download ]

Layer settings
Device
[ LUSB:Auto f—i—/ Search device
Position: iCurrent positic % |

4.1 Search Device

Link device in two different ways: USB and network.But through some equipment port button on the

popup dialog box, set connection mode and choose connection port.

& UsB: ‘:Auto V
() web:

Default IP: ‘ {

If the computer only connected one device, you can set to Auto. The software will automatically search the

device.

If the computer connected many devices, then first of all you need to click [Find com] .

After search, the connected devices will all add to the drop-down list.

What you need to do is select the specified device.

Network: if the computer is connected only a laser equipment, which can be directly in the default IP address to
enter in connected device IP.

When the computer connection has many sets of laser equipment, and USB operation is similar.

Search at present already connected device, and choose from the drop-down list corresponding IP address

machine.

4.2 Layer processing

First, in the menu [Handle]->[ Path optimize] check “according to layer order”, then click “OK” to exit.
Layer reorder: Click button Up, Down can change the order of layers, or direct the mouse to drag the layer
to the specified location.

Here, you must check the “Path optimize” option.
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4.3 Position

Setting the laser head back location after processing completed.(Current position. Original anchor. Machine
Zero.

Current Position : Laser head back to the position before processing.

Original anchor : Laser head back to the last anchor ,the anchor may set at panel.

Machine zero :  Laser head back to the zero of the machine.

4.4 Go Scale. Cut Scale

For Example Go Scale, As the following figure shown, the actual graphic is round, and the red rectangle
outside the circle is the smallest rectangle, click button Go Scale, laser head will run once along the rectangular

path.

For Example Cut Scale, As the following figure shown, the actual graphic is round, and the red rectangle

outside the circle is the smallest rectangle, click button Cut Scale, laser head will be cut along the rectangle.

4.5 Start. Pause. Stop. SaveToUFile. UFileOutput. Download

Start: Output the current graphic to the machine for processing.

Pause\Continue: Click Pause, will stop the processing work, click the button again to Continue

Stop: Stop the current processing work

SaveToUFile:

Save current file as RD format, using for offline processing ( Can be copied to other memory board for full
offline operation)

FileOutput:

Output the offline file (RD format)

After save offline file, click UfileOutput to select rd file to processing.

Download:

Download the file to the memory of the controller , then user can start the file through the machine panel.

4.6 Output select graphics

After check Output select graphics, then only output the selected part, rather than not output the part not

selected.
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4.7 Path optimize

After check Path Optimize, then automatically perform the path optimize before the output.

If has done the Path optimize or not need optimize, then not check Path Optimize can reduce waiting time.

4.8 Test

v Work VOutput Doc VUser | Test ‘Transform

[ Current Position | X=?
Y¥=2?
Z2=?
| L
| Axis Move :
Offset{mm}); 10]
Speed(mm/s): S0
| X- |-Iome ‘ A+ ‘-lome Power(%): '0
[IMave From origin
¥~ z- 3
[]1F Light

Axis control, can only control one axis each time. You can set the information for axis move, including move
length. speed. laser on-off and laser power.

If you check “Move from origin”, then the offset you set means the offset to machine zero.

If you not check move from origin, then the offset means the offset to the current position.

The X-axis, for example, assuming the current position is 100mm, such as the step distance is set to 10mm,
then the exercise once, the new location will be 110mm, such as the check moves from the origin, movement
time, the new location will be 10mm, and repeated Movement, location will no longer change.

Note: According to the provisions of the controller, the absolute position is no negative in the whole breadth. If

you check the Move From Origin, and set the offset value negative, then the machine will hit limiter.
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4.9 Output Setting

Work | Output |Doc User | Test | Transform

|:] Enable rotate engrave

Circle pulse:

Diameter(mm): |

Speed({mm/s): 7

[T]Enable feeding
Feeding Count:

Distance{mm):
|:] Backlash reapy optimize

[]Enable offset of Laser2

X i

4.9.1 Rotating sculpture

[ Enable rotate engrave): After enable engraving, the actual precision of Y-axis will be based on diameter and
step per rotate to auto match the setting of pulse precision of Y-axis. In addition, the work area in the main
interface will also change.

[Diameter]: The diameter size of the parts.

[ Step per rotate]: The number of pulse corresponds to the workpiece rotate one week.

[ speed 1 : testthe speed of work.

The function is to facilitate the users to replace parts, and different size of the workpiece when the

workpiece is not very different before use. When the relatively large difference in size of the workpiece, it is
recommended to use directly modify the motor step approach to implementation.

Rotary engraving is only when using the rotation axis to replace the Y-axis use.

4.9.2 Feed Setting

To use the feed, must first enable the feed.

After set feeding parameters, the shaft will be feeding a feeding length, and repeat the process , until the times
of processing reach to number of feeding.

If the machine is not equipped with feeding devices, in general, enable the feed ban.

4.9.3 Optimization of Backlash Compensation

When the machine there is space (such as dislocation of the seal cutting graphics), can be checked.
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4.9.4 Optical 2 migration

In need laser collaborative work, complete the same graphics processing occasions, usually, to use the
optical 1 to define the graphics location, then if the optical 2 can accurately with the optical 1, will need to

specify the optical 2 relative to the optical 1 offset.
This generally used in two power different laser tubes of machine, because two of laser tube power

different, cause different functions.
If some machines equipped with two different power of laser tube, a responsible for cutting, a responsible

for sculpture.

4.10 Layer Settings
x
Work jioutputr Doc | User | Test rTransformr
Laver Mode Speed Power Qutput

B 100.000 30.000 Yes
B Cut 300.000 30.000 ves

M
i
-t
i
o

[ Up ] [ Down ]

Linecolumn setup

Mum space(mm) Dislocation{mm}) H
i1 0 0

Wi o b |(eesen)

4.10.1 Ranks se
For convenient to set in machining graphics processing on the array.
X numbers and Y numbers, which was the array of columns and rows.
X intervals and Y interval, respectively is array of the column spacing and line spacing.

Layer: Software use layer to distinguish processing graphics parameters of different layers.

-1

If hope X interval and Y interval which between is representative of array center of the graphics spacing can

E-E .

.The X interval is said and Y representing between interval graphics margins.

switch to
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Adjust the X, Y interval between enable graphic layout more closely, can click drawing area, make graphics in
the selected state, and then through the keyboard of the up and down or so key to adjust, and rolling the mouse
can be displayed scaling, make the spacing of the adjustment process more precise.

[ Bestrewing breadth ] :According to the size of the wide and the current user Settings ranks spacing, to
determine how much can output the most listed (i.e. X number) how many lines (i.e., Y number). Click on the

button [ Brestrewing breadth] , pop-up interface as shown in figure

Bestrewing breadth @

% breadth{mm):

¥ braddth(mm): féod

[ Ok ] L Cancel J

According to determine the button, the software can automatically calculate the entire width of the ranks of
the arrangement number.
[ dislocation ] : for some graphics, in arrangement, the dislocation arrangement, can make the arrangement

more compact.

[ The application to copy ] in good array, chosen to copy graphics, some application to copy, already can

duplicate array graphics.

In the layer list to edit the double click inside layer, namely will pop up layer parameter dialog box.

The left article color, representatives of the current graphics layer, choose different color, can be in already
switch between different layer, one-time modified multiple layers of parameters.

The layer parameters is divided into two parts: public layer parameters and turn a layer parameters.Public
layer parameters is to point to no matter how the layer processing type, all effective layer parameters;

Proprietary layer parameters is to point to the layer of processing type change of the corresponding

parameters will also be changing.
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Layer Parameter @

FAN [ Load parameters from library
3]
= Layer: _
Is Output:
Speed{mm/s): []pefault
If Blowing: | Yes
Processing Mode: | Cut 'v
Min Power(%) Max Power(%)
Laserl: '30 130 [Joefault
Laser2: ‘ ‘ l ‘
Seal: (0-000 |mm
Open Delay: iU ’ ms
Close Delay: |0 \ ms
Laser through mode
7 [ Ok ] [ Cancel ]

4.10.2 Laser Scan Parameters Setting

Layer: _
Is Qutput: Yes v
Speed(mm/s): {400 []pefault
If Blowing: | Yes =

Processing Mode: fCut =

Min Power{%) Max Power(%)

30 Y | Clpefaut
| I

Laser:Software to distinguish between different layers of the graphics processing technology parameters.

Laserl:

Laser2:

For scanning processing methods, more are in the same layer bitmaps, and whole as a picture output, if hope
each bitmap single output, it can be a graph respectively placed in different layer can.

Is Output:Have two options: yes and no. Choice is, the corresponding layer will output processing; Choose
no, won't output processing.

Speed: The corresponding processing method of processing speed.

For cutting processing is concerned, the slower, processing the better, the more smooth track; The faster the
processing results, the worse the trajectory smooth;

To scan for processing, the slower, under the same energy scanning depth, deep and scanning trace the thick,
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scanning the resolution also reduced.

The faster the same energy the shallow depth of the scanning, details distortion increase.
To fix for processing, the main change is empty the speed of the move.

If, check the "default", the actual speed by panel set up to speed.

"

If Blowing:f the machine external fan, and fan has enabled, then if choose "is", then this layer data
processing, will open the fan, otherwise, will not open the fan. If you do not make can fan, no matter choose
"yes" or "no", are meaningless.

Processing methods: says the method of processing corresponding layer;

If the currently selected is vector layer (i.e. color layer), it includes three choices: laser scanning, laser
cutting, laser rbis;

If the currently selected is a tutu layer (namely BMP layer), the only include a choice: laser scanning.

Laser 1, laser 2: corresponding to the mainboard laser signals 1 and 2 of the way way laser output. If it is
only head machine, the second road laser meaningless.

The minimum power, the maximum power: the power of the values of the range of 0 to 100, said that in
the process of the strength of the laser processing; Big value, the laser is strong, is small, the laser weak.
Minimum power loss to the most power is less than or equal to.

For different processing type has a different meaning.

For cutting processing, the actual power is cutting speed and phase follow, speed, low energy is also low,
high speed is high also, so that we can guarantee the whole process of cutting energy evenly.So the minimum
power the speed of the corresponding minimum energy, the minimum speed general is 0, but if set the speed is
the minimum speed for takeoff take-off speed; The maximum power correspond to the layer speed.

Set minimum power, and the most high power flow:

1> The minimum power and the maximum power set to the same value, synchronous adjustment. Until all
the cutting curve are already appear.

2> The maximum power unchanged, and gradually reduce the minimum power until the energy of the
heavy cutting curve at the lowest level, and all of the cohesion parts can be processed to come out.

3>If not yet to best effect, can be the most appropriate fine-tuning high power, and repeat step 2.

If is cut through, the minimum power loss and the maximum power no significant difference, can be set to
give the same.

To scan processing, ordinary scanning, the minimum power and the maximum power must be consistent.
Slope sculpture, minimum power loss is the power of the corresponding factors, the most power is the power of

the bottom of the corresponding.

L

/

Mimimum power 1oss 1s the top for the small slant wide, detail place distinguish clearly.

top

bottom

Minimum power loss is too large slope not obvious.
To fix processing, the minimum power and the maximum power can be set to agree.
If checked "default", the actual power panel set by the power to determine.

Click the button "advanced", but also can be set to other layer parameters.
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Other layer parameters @

["]Enable pen up and down
mm

| mm
Speed:{mm/s):

Point —
Dot interval(s) a

Extend IO output

[J1o1

- [ Cancel J

[ Pen up and down] If machines have installed the lift platform, and need to be in a different platform height
on the processing, can make can write up function.

Here the corresponding is platform write position in which high on the processing, carried the
corresponding is empty pen position before go, platform should be moved to which level in the optical
translation will not again to interfere with the process workpiece. If confirmed the optical not and the
translation of the process workpiece to interfere, don't need to set up the pen position.

Use way is:

1> Can write pen to carry.

2>Make can write position, manual control panel key mobile platform, to stay processing graphics
graphics processing plane, adjust the focal length. Then click button "read", and then write all set up position.

3>That can carry a position, manual control panel key mobile platform, move to the optical will not
interfere with the work of the height, and through the panel key move the optical, confirmed that won't interfere,
some button "read", and then set up a position.

[ point]

Here the rbis, and is suitable for drawing tool create a point figure yuan, or from DXF file into the spot
diagram yuan. And the current layer processing methods has nothing to do, namely whether the current layer is
cutting or a scan, graphics in the spot diagram yuan has always been to the rbi way output.

The rbi movement speed for layer speed, beating the energy for the maximum energy layer laser.

[ The laser Enable]
When the machine is equipped with two road laser, usually, are two road and output.
But the user may through the set that laser, that its not output all the way.
[ The joint IO output ]
All the way and the layer associated 10 output, obligate function.
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4.10.3 Laser scanning parameters Settings

Layer Parameter @ Layer Parameter
o [ Load parameters From library ] : - [ Load parameters from library ]
= i P
=3 Layer: _ Layer:
1 [ Is Qutput: | Yes v Is Qutput: |Yes v
Speed({mm/s): 100 []Default Speed(mm/s): ‘100 | []oefault
If Blowing:  Yes v If Blowing:  Yes v
Processing Mode: | Scan v Processing Mode: -
Min Power(%) Max Power(%) Mirj Power(ff?) Max Power({%)
Laserl: |30 | 130 [ oefault Laserl: |30 |30 ‘ [Joefault
Laser2: Laser2: ‘ ‘
Optimized ] DNegative Engrave |:| Optimized Scan
[[J1independent output [[] output direct [TJindependent output
[[Jramp Effect
Ramp Length: \ mm Ramp Length: | | mm
Overstriking: |Un-process | v Overstriking: Un-process | v
Scan Mode: | ¥_swing v Scan Mode: | X_swing x
Interval(mm): %U-l | Interval{mm): (0.1
Jlikosci = - [ i = -

~ [ ok | [ concel | v [ ok | [ cance |

On the left of the dialog box for vector scanning parameters Settings, on the right side of the dialog box for
bitmap scanning parameters Settings.
The vector data do not support the scanning the color carving, optimization scanning, direct output.
The color carving: normally scanning, bitmap in the black spots a laser, the laser in white.
Choose the color carving, the bitmap in the white of the laser, black spots in a laser.
Optimal scanning: choose optimization will automatically adjust the users scan the scanning interval to set up

the best value, the scan best effect.

Otherwise, according to user Settings of the scanning interval scan pattern. Generally choose "optimal
scanning"

Direct output: grayscale bitmap, according to the actual graphics gray.in output, already color deep place laser
energy big, color shallow place laser

Energy is small.

Figure yuan respectively output: for vector graphics for, figure yuan respectively according to vector diagram
output is the position of the yuan relationship, which in turn will get together the vector map carving output of
yuan respectively.

If not checked figure yuan respectively output, it will be the whole vector graphics as a whole to
sculpture.

For a bitmap for, if not checked figure yuan respectively output, the system will automatically will work
with a layer of the bitmap in as a whole output.
If checked the figure yuan respectively output, the system will be in a single output bitmap.
Slope effect: the scan the edges of the figure appear slope, submit stereo effect.
Be bold font: including don't handle, scanning the font, scanning the bottom. Generally choose not processing.
Scanning is part of the font scanning is the font, also is the Yin carving.

Note that the slope effect choice, please will be bold font choose not to deal with, or slope affected the effects.
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Font Yin carved: not to add text outside the box, scanning are text itself, as below:

XK 01

Font Yang carved: text and the outer frame, scanning is the bottom of the graphics, as below:

¥ 30 15 F

Scanning mode: including level one, level two-way, vertical one-way, vertical two-way.

Level one way: the optical scan pattern back and forth in a horizontal direction, but only to a direction
when laser scanning comes out,Such as: when the optical scan from right to left a laser, and from left to right
the laser scan.

Level two-way: the optical horizontal direction in the back and forth laser scanning graphics.

The vertical one way: the optical scan pattern in vertical direction back and forth, but only to a direction
will be laser scanning,Such as: when the optical scan from up to down a laser, and from the bottom to scan a
laser.

The vertical two-way: in vertical direction the optical back and forth laser scanning graphics.

Note: general use level two-way scanning mode.

Scanning interval: namely the optical scan every much long distance under a line. The smaller the interval,
scanning the deeper to graphics; Conversely, the more shallow.

Suggestions: (1) for vector layer (i.e. color layer), scanning interval in 0.1 mm general set below.

(2) for a tutu layer (namely BMP layer), scanning interval in 0.1 mm general set above,
Then through the change and the most high power to make the minimum power after scanning the

graphics depth to achieve the ideal effect.
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4.10.4 Laser Cut Parameters Setting

Layer Parameter @

L Load parameters from library

i
Lever:
Is Output: v

If Blowing: | Yes

Laserl: ['30

Laser2: ‘ -

Speed(mm/s): 100 ! []pefault
v

Processing Mode: | Cut v

Min Power(%) Max Power(%)

30 ' []Default

Seal cutting has not closed the graphics
appear the case is closed, you can
compensate with the seal to close, but if
the seal is misplaced, you can not
compensate, you can use 4.95
optimization backlash compensation to
compensate, or to use the user parameter

in the Backlash compensation .

—— »
Seal; |0.000 /,.m/
Open Delay: ‘[U—”I’ms/—# Open delay
Close Delay: U— ms
7 = "] Close delay
Laser through mode
\ If checked, the light switch delay is
— [l playing in time said.
~ [ Ok ] [ Cancel ]

Otherwise, the light switch delay said
is laser movement delay.

Using the slit width compensation can compensate for the offset between the graphics and the actual output

graphics that caused by laser cutting.

It only has effective for the closed graph.

Direction: Compensation direction is set according to actual needs, such as cutting a circle, if you want to

retain the cutting down of the circle, you should set out the direction of compensation; If you want to keep the

hole should be set to compensate for the inward direction.

Sew width: it is the width of the laser.

Other cutting param @

[TJEnable sew compensation

Direction:
Sew width 1‘r mm
[ Ok | [ Cancel ]
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4.10.4 Laser Dot Parameters Setting

Layer Parameter @

Layer:

Is Output:
Speed(mm/s);
If Blowing:

Processing Mode:

[
|
|
|

Yes v
100 ' [Default
Yes v

Laserl: ;30

Laser2: ‘[30

Dot interval: !5l

| I

Min Power{%) Max Power(%)

K "30 !DDeFault

Dot time: 01 /
Dot length: 0 _{‘.-mn—"’
[]center dn\

Ok

] [ Cancel

]

The time for emitting laser on
one dot during the process. The
higher the value is, the darker

The interval between the dots

Dot length, for cutting dash line

Only dot at center
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Chapter 5 Daily Maintenance and Basic Fault
Analysis

Correct operation and daily maintenance play a significant role in machine’s
long term performance. The following is a listing of items requiring periodic
maintenance and a table for fault analysis.

1. Daily Maintenance:

A. Water changing and water tank cleaning (we advise you change the water
and clean water tank once every two months).

Caution: make sure that laser tube is filled with water before restarting the
machine.

Water quality and the temperature of the cooling water affect the life of the
laser tube. You need to use pure (distilled) water and control the temperature below
35 centigrade (95 degree F). All machines sold in the US and Canada are equipped
with a refrigerated water chiller, which will automatically maintain the proper
temperature. On machines with a coolant tank, you may need to change the water
or add some ice into the water when temperature rises above 35 centigrade. (We
advise the user to use the water chiller or double water tanks)

Water tank cleaning: turn off the power and pull out the water inlet pipe to let
the water drain from the laser tube by gravity, then open the water tank and remove
the water pump, cleaning the dirt on the pump. Clean the water tank and change
cooling water, reinstall the pump and reconnect the water supply pipe, turn on the
pump for 2-3 minutes in order to fill the laser tube with water.

B. Blower cleaning

A blower, used for a long time, will accumulate solid dust, causing it to run
noisily and at reduced efficiency. When this happens, disconnect the power to the
blower and then the hoses. Clean the blower (and all the vanes) and reconnect.

C. Cleaning of Mirrors. For the machine to run at maximum capacity, we
advise to check the mirrors before work everyday. Caution: make sure the power is
off.

The diagrams in chapter 4 show that the machine has 3 mirrors and a focusing
lens. The #1 mirror is the first one from the laser, or in the rear left corner of the
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machine. #2 mirror is mounted to the left end of the gantry and the #3 mirror is at
the top of the focusing head. The focusing lens is mounted to the bottom of the
adjustment tube below the focusing head.

The mirrors will easily get dirty, which will cause the laser power to diminish.
Laser energy absorbed into a dirty mirror will also heat and destroy the mirror. The
cleaning of the first two mirrors is easy as they do not have to be removed from the
machine. Just wipe them carefully with lens cleaning paper, dipped in cleaning
solution. The mirror in the focusing head and the lens need to be removed, carefully
cleaned and reinstalled.

Caution:

A. Mirrors must be wiped carefully in order to avoid destroying their surface
coating.

B. Do not touch cleaned mirror and lens surfaces as this will deposit a new
layer of oil on them.

C. The concave side of the lens must be on the bottom when installed.

D. Cleaning of the rail (we advise you to clean the rail twice a month, when
machine is power off)

Caution: cleaning preparation —dry cotton, lubrication.

The slides of the engraving machine consist of rail trolleys. In the RX machine
series, we are using trolley rails in all directions.

Cleaning of the rail: first move the laser head to the right (or left) side, find the
rail, use dry cotton to wipe it clean and add some lubrication on it, move the laser
head from right to left slowly several times to allow the lubrication to distribute
equally.

Trolley
slide bar




To clean the trolley rail, move the gantry to the rear and open the covers on
both sides of the machine. Find the rails as shown in the above picture and clean
using a clean cotton rag. Move the gantry forward and clean the rear area.

E. Checking the Beam Path

The beam path includes 3 mirrors and a focusing lens. To avoid the possibility
of stray beam reflections, the beam path should be checked for obstructions before
starting the machine.
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Basic Fault Analysis

No. | Problem Solutions
Check whether the power is | Connect all lines
Machine ON, firmly.
1 doesn’t Correct the
enorave Check the parameters of the _
grav _ parameters according
main board.
to manual.
Refer to the software
5 Continuous | Check the parameters of the | instruction and
laser power | mainboard. correct the parameter
of laser.
Correct the
3 Abnormal Check the parameter of the | parameters for the
reset mainboard. gantry according to
the manual
Clean the water tank
Check whether water ,
, and pump, drain the
Engraving flows smoothly, _
4 water pipe

depth varies

2.Check  whether power
supply is steady

Use manostat to
input power supply
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Dimension

does not fit

Check the
proportion is 1 to 1 when you

whether

output with BMP format in
Coreldraw9.

Change it into 1 to
L.,

Check whether the total
figure points has exceeded
10,000.

Reduce the

points. .

figure

3 . when customer uses
Coreldraw9 to output with

PLT format, check whether

Change it to 100%

Cannot
download
the
Computer to

from

the machine

the zoom in the HGPL
dialogue box is 100% or not.
Check the | Referring to using
parameters in the | explanation, and
mainboard change parameter.
1. Is the USB driver
installed?

Select correct port.

2. Is the power is on.

Turn on the power.

3. Is there any problem
with the USB.,

Reinstall the drive.

4. Check  grounding.

Install ground.

1. Is there any stray beam

Adjust the beam path

Er.lgrave path 2 according to chapter

without 8.

imprint 2. Is there any damage to | Make water flow
the water system? freely.

Can’t  find | 1. Trouble with computer or | 1. Change computer

laser device

USB.

or change USB cable
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Chapter 6 Warranty

Laser machine warrants that all laser systems will be free from defects in material
and workmanship under normal and proper use and service, for a period of one
year from the shipping date from Laser machine’s factory. The laser tube is also
covered by this three month warranty. Notwithstanding the foregoing, Laser
machine provides no warranties whatsoever on any software used in connection

with the system.

This limited warranty extends only to the original purchaser and is not transferable.
During the applicable limited warranty period, Laser machine will repair or replace,
at its option, any defective product or part at no additional charge to the customer,
provided that the defective product or part is returned to Laser machine. This
limited warranty does not extend to any products or parts that have been damaged
as a result of lack of supervision of use, accident, misuse, abuse (including, without
limitation, incorrect voltages, power surges, fires, improper or insufficient
ventilation, failure to follow operating instructions provided by Laser machine,
"acts of God" or other situations beyond the control of Laser machine, or as the
result of service or modification by anyone other than Laser machine. This limited
warranty does not extend to parts or components that are not installed by Laser
machine or by an authorized representative of Laser machine, or in a manner not
approved by Laser machine. All optics such as beam expander, lens, mirrors,
beam window etc..are not covered under warranty. Honeycomb Cutting bed is not
covered under warranty. They are considered as consumables.

Laser machine Systems reserves the right to request that a laser system be returned
to the factory for repair, or to provide on-site repair. If parts are returned to factory
for repair during warranty period, due care will be taken to repair and return as
soon as possible within 4 weeks after receipt. If our technician decides that the
part has been damaged due to customer’s carelessness, warranty will be void. If
parts of components are dismantled without our technician’s permission, warranty
will be void.
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If determined by Laser machine that on-site repair is necessary and the nature of the
repair is such that Laser machine believes that it can be done at the customer's
facility, Laser machine will provide a field service technician during the applicable
limited warranty period. All travel expenses and service fees will be charged.
Only parts are covered under warranty.

Limitation of remedies and liabilities: Laser machine entire liability and
customer's exclusive and sole remedy for damages from any cause whatsoever
(including without limitation any nonperformance, misrepresentation, or breach of
warranty) shall be limited to repair or replacement of the specific products or parts
that do not comply with the limited warranty given by Laser machine. Any
products or parts repaired or replaced by Laser machine pursuant to this paragraph
shall be warranted as of the original date of delivery of the laser system in
accordance with the terms and conditions herein for the duration of the applicable
term of the limited warranty. In no events will Laser machine be liable for any
damages caused, in whole or in part, by customer, or for any economic loss,
physical injury, lost revenue, lost profits, lost savings or other indirect, incidental,
special or consequential damages incurred by any person, even if Laser machine
has been advised of the possibility of such damages or claims.
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